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H & H Abréviation utilisée a bord de |'Enterprise

pour désigner le spécialiste responsable du domaine
«Archéologie et Anthropologie ». Lorsque le vaisseau
se pose sur la planéte Pollux IV, en 2267, le lieutenant
Carolyn Palamas est |'officier A & A. — Journal de
bord : « Who Mourns for Adonais » (Pauvre Apollon)
[ST:LSC] VOIR DOSSIERS 20, 68

HF Initiales d'une amie et condisciple de Jean-Luc
Picard a |'Académie. Picard a un jour grave ces
initiales sur I'orme favori de Boothby, et il a souvent
prétendu qu'A. F. lui avait fait rater I'examen de chimie
organique. — Journal de bord : « The Game » (Le Jeu)
[ST: LNG] VOIR DOSSIER 69

Hﬂm", ﬂm"ﬂl ‘Officier‘de Starfleet Command,

au Q. G. de Starfleet a San Francisco. Il a succombé

a une intelligence extraterrestre jusqu'alors inconnue,
avec d'autres membres du commandement. — Journal
de bord : « Conspiracy » (Conspiration) [ST: LNG]

VOIR DOSSIERS 19, 69

thﬂm Il lutte contre le régime nazi sur la planéte
Ekos, en 2268, en tant que membre de la résistance
de Zéon. Avec son frere Isak, il a aidé Spock et Kirk

a trouver John Gill, attaché culturel de la Fédération.
— Journal de bord : « Patterns of Force » (Fraternitaire)
[ST: LSC] VOIR DOSSIER 68

Kirk est tout prés d’étre «absorbé » par la

communauté de la planéte Béta Ill. Ce n’est
qu’aprés avoir été sauvé par des membres d’un
mouvement clandestin anti-Landru qu’il apprend
Ia véritable nature de Landru : c’est un ordinateur.

-
ﬁhSUmE Ce terme s’applique aux habitants de la
planéte Béta lll placés sous le controle de I'ordinateur
‘Landru. Un individu « absorbé » perd son libre arbitre et
ne peut plus agir que de la maniere jugée par Landru
comme la plus avantageuse pour la communaute. —
Journal de bord: « Return of the Archons » (Le Retour
dés Archons) [ST: LSC] VOIR DOSSIER 68

Htﬂdémm [‘B SrﬂfﬂEEt voir Starfleet,

' Académie de VOIR DOSSIER 19

" DOSSIER 81 || FICHE1 _
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Depuis sa fondation en 2161, I’Académie

de Starfleet a formé des milliers d’éléves
officiers. Elle est située a San Francisco, dans
la méme zone que le Quartier Général de Starfleet.

fAcademie, officier des simulations de |

Officier de Starfleet chargé de I'encadrement de la
zone d’exercices de I’Académie. — Journal de bord:
« The first Duty » (Prise de commandement)

[ST: LNG] VOIR DOSSIERS 19, 69

fAcademie, zone d'exercices e | cexe

région de I'espace dépourvue de planétes, voisine de
Saturne dans le systéme solaire, est réservée aux
manceuvres de vol et autres exercices effectués par
les éleves officiers de |'’Académie de Starfleet.

L'un d'eux, Joshua Albert, périt accidentellement dans
cette zone en 2368. — Journal de bord : « The first
Duty » (Prise de commandement), « The Lower Decks »
[ST: LNG] VOIR DOSSIERS 19, 69 :

HCﬂmﬂf l" Planéte d'origine des Acamariens,

mais aussi des Détrousseurs qui ont quitté Acamar lll
pour devenir des pirates de I'espace. Site de la rencontre
entre Jean-Luc Picard et la dirigeante acamarienne,

la Souveraine Marouk. — Journal de bord :

« The Vengeance Factor » (Vengeance) [ST: LNG]

VOIR DOSSIERS 3, 69

Acamar, SUSEME 0 systrme sttaire dans

lequel se situe la planéte Acamar lll. — Journal de bord:
« The Vengeance Factor » (Vengeance) [ST: LNG]
VOIR DOSSIERS 3, 69

Hﬂﬂmﬂflﬂns Les habitants de la planéte Acamar llI

se répartissent en plusieurs peuples étroitement
apparentés. Leur aspect physique est trés proche de
celui des humains, & I'exception d'un profond sillon
vertical qui leur barre le front. Les Acamariens ont
souvent le visage tatoué. La culture acamarienne est de
type clanique : le statut social et le pouvoir politique sont
en grande partie déterminés par le rang de I'individu au
sein de son clan. Les heurts entre clans et factions sont
fréquents et souvent violents. Un conflit long de trois
cents ans a notamment opposé les Tralestas aux
Lornaks, et s'est soldé par |'extermination des
premiers. En 2366, I'issue d'une autre querelle sera
toutefois moins tragique : Jean-Luc Picard, dans un role
de médiation, obtient une réconciliation permanente
entre le gouvernement acamarien de la Souveraine
Marouk et les Détrousseurs nomades. — Journal

de bord : « The Vengeance Factor » (Vengeance)

[ST: LNG] VOIR DOSSIERS 18, 69

acces, ter
‘ acces, tunn
. Accolan
acéton, assimilatear
acétylcholine ‘
~ Achille
| actinides
Adam
. Adams, Dr Tristan
Adele, tante
~ Adelman, Institut neurologique |

La Souveraine Maroulk,

dirigeante acamarienne,
fait appel a Picard pour
négocier une tréve avec les
pirates de I'espace que sont
les Détrousseurs acamariens.

Brull, I'un des

Détrousseurs acamariens,
constitue le premier lien vers
le retour des siens sur la
planéte mére.
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acces, ferminal 0 -or ce

connexion utilisé sur les vaisseaux
des Borgs qui permet aux individus
de communiquer avec leur collectif.
— Journal de bord : « Q Who ? »
(Docteur Q) [ST: LNG]

VOIR DOSSIERS 15, 69

.

Ce Borg est branché sur

le collectif via le terminal
d’acceés, ce qui permet le transfert
d’informations, dans un sens
ou dans l'autre.

acces, funnels d° se

passages au sein de Deep Space
Nine, contenant des circuits et des
équipements utilitaires cruciaux,
comparables dans leur conception
aux tubes de Jefferies que |'on
trouve sur les vaisseaux spatiaux
de la Fédération. Ces tunnels sont plus grands que les conduites
ordinaires, afin de procurer un acces facilité aux équipes de
maintenance. Le virus de I'aphasie s'est répandu a partir d'un dispositif
caché dans le tunnel d'acces contenant les circuits de réplication des
aliments. — Journal de bord : « Civil Defense » [ST: DS9]

VOIR DOSSIERS 27, 70

Jake Sisko se déplace au

coeur des tunnels d’accés
de DEEP SPACE NINE; il tente
ainsi de contourner les anciens
systémes de sécurité
cardassiens.

HCEUIﬂ" Cet artiste habitant la planete Aldea, aurait adopté Harry
Bernard Jr, le fils d'un membre d'équipage de I'Enterprise-D, si tous
les enfants n'avaient quitté Aldea en 2364. — Journal de bord :

« When the Bough Breaks » (Quand la branche casse) [ST: LNG]
VOIR DOSSIER 69

ﬂ[:ém", ﬂSSIm"ﬂrEUI ﬂ‘Puissante arme des Menthars, capable

de drainer |'énergie provenant d'une source éloignée (un vaisseau
spatial, par exemple), puis de la convertir en rayonnement destructeur
contre des équipages ennemis. Les Menthars emploient avec une
grande efficacité des assimilateurs d’acéton dans leur guerre contre
les Proméliens, en dissimulant des milliers de ces dispositifs dans une
ceinture d'astéroides proche d'Orelious IX. Les assimilateurs d'aceton
peuvent rester actifs pendant plus de mille ans. En 2366, |'Enterprise-D
est endommagé par les assimilateurs dont les Proméliens furent
victimes un millénaire plus tot. — Journal de bord : « Booby Trap »
(Pieges !) [ST: LNG] VOIR DOSSIERS 60, 69

acafyicholine coe

matiére biochimique agit
comme un neurotransmetteur
qui déclenche des impulsions
électriques entre les neurones
de toute forme de vie a base
de carbone. Spock effectue
un test a l'acétylcholine sur

la gigantesque amibe qui
s'est attaquée au systéme
Gamma 7A en 2268;

McCoy affirme d'ailleurs qu'il
s'y est mal pris. — Journal

de bord: « The Immunity
Syndrome » (Amibe)
[STHESC]

VOIR DOSSIERS 5, 68

Achille, un esclave
entretenu en vue de combats
de gladiateurs sur 892-1V,
est opposé dans I’'arene
au Dr McCoy, en 2266.

DOSSIER 81 | FICHE 1 |

HChl"E Célebre gladiateur, nommé d'apres le personnage de la
mythologie grecque, héros de L’lliade d'Homere. En 2267, il lutte contre
Spock et McCoy dans |'aréne vidéo de la planéte 892-IV. — Journal de
bord : « Bread and Circuses » (Sur les Chemins de Rome) [ST: LSC]
VOIR DOSSIER 68

ﬂl:nmﬂes Ce terme scientifique désigne certains composés
radioactifs généralement contenus dans le minerai d'uranium. Différents
actinides, présents au sein de la ceinture
d’astéroides ikalienne, empéchent en 2367
les senseurs de la Fédération de trouver

les rebelles kriosiens actifs dans cette région.
— Journal de bord : « The Mind’s Eye »

(Vue de I'esprit) [ST: LNG]

VOIR DOSSIERS 5, 69

Hﬂﬂm Vagabond, musicien, idéaliste, disciple
du Dr Sevrin mort en 2269 dans la quéte de
la planete parfaite, Eden. Ayant cru a tort avoir
découvert Eden, Adam succombe, victime de
la toxicité d'un fruit saturé d'acide consommé
sur la planéte inconnue. — Journal de bord :

« The Way to Eden » (Le Chemin d'Eden)

[ST: LSC] VOIR DOSSIER 68

Le jeune chanteur

Adam, disciple
du Dr Sevrin, meurt
avant d’avoir trouvé
la planéte Eden.

Hﬂﬂms, [l[ msrﬂﬂ Directeur adjoint de la colonie pénitentiaire

de Tantalus V, Tristan Adams en prend le contrble en 2266 ; son
supérieur, le Dr Simon Van Gelder, est devenu fou pour s'étre exposé
aux effets d'un neutralisant neural expérimental. Ce dispositif sera fatal
au Dr Adams lui-méme. — Journal de bord : « Dagger of the Mind »
(Les Voleurs d'esprit) [ST: LSC] VOIR DOSSIER 68

A I’abri derriére sa vitre, le Dr Tristan Adams essaie de
soumettre le capitaine Kirk a un « lavage de cerveau » a I'aide
du neutralisant neural mis au point sur Tantalus V.

~
HUE|E, l.a"m Parente de Jean-Luc Picard, auprés de qui celui-ci
a appris les divers « remedes de bonne femme » qu'il emploie toujours
pour traiter les affections mineures. Parmi ces remédes figurent la
muscade contre I'insomnie et la tisane au gingembre contre le rhume.
— Journal de bord : « Cause and Effect » (Cause et conséguence)
[ST: LNG], « Ensign Ro» (Enseigne Ro) [ST: LNG],
«Schisms » (Schismes) [ST: LNG]
VOIR DOSSIER 69

Adelman, Insfifut neurologigue cewer seoissement

spécialise dans la recherche biomédicale, Le Dr Toby Russell y a exercé
en 2368. — Journal de bord : « Ethics » (Ethique) [ST: LNG]
VOIR DOSSIERS 7, 69
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H[IEII]m, USS Vaisseau spatial de la Fédération,

de classe Ambassador, immatriculé NCC-26849.
Le capitaine Darson, commandant I'Adelphi, fut tué
ainsi que gquarante-six membres d'équipage lors
d'une tragique tentative de contacts avec la planéte
Ghorusda. Cet événement est resté dans |'histoire
sous le nom de désastre de Ghorusda.

— Journal de bord : « Tin Man » [ST: LNG]

VOIR DOSSIERS 31, 69

Hnemhﬂus N Cette planéte constitue I'objectif de

|’U.S.S. Enterprise NCC-1701-D aprés sa confrontation
avec |' Oiseau-de-Guerre romulien Devoras, en 2367.
— Journal de bord : « Data’s Day »

(Une Journée de Data) [ST: LNG]

VOIR DOSSIER 69

ﬂmenﬂlme Stimulus chimique basé sur une

hormone anthropoide, I'épinéphrine, utilisée comme
médication premiere contre I'empoisonnement

par les radiations dans les premiers temps de |'ére
post-atomique. Le Dr McCoy |'emploie a bord de
I'U.S.S. Enterprise pour traiter les membres
d'équipage victimes d'une maladie due a des radiations,
qui provoque chez eux un vieillissement accéléré.
['adrénaline est remplacée en 2267 par une substance
plus efficace, I'hyronalyne. VOIR DOSSIER 68

ﬂemnﬂm Moyen de transport local. Les aérotrams
sont couramment utilisés par le personnel de Starfleet
dans le secteur de San Francisco. — Journal de bord :
Star Trek: The Motion Picture (Star Trek: Le film)
VOIR DOSSIER 72

Hﬂﬂmemnﬂn, ”55 Ce vaisseau de la

Fédération, de classe Apollo, immatriculé NCC-11638,
a recu le nom du général grec qui mena le siege

de Troie dans la légende terrienne dite de la « Guerre

de Troie». L'Agamemnon joue un role clé au sein

du corps expéditionnaire numéro Trois mis sur pied
par Jean-Luc Picard en prévision d'une invasion des
Borgs, en 2369. — Journal de bord: « Descent, Part 1 »
(La Descendance, 1t partie) [ST: LNG]

VOIR DOSSIERS 31, 69

ﬁﬂe WHSCE"S"]" Rite initiatiqgue en vigueur dans

I'Empire klingon, au terme duquel un individu accede
spirituellement au statut de guerrier. Ce rituel comprend
un serment dont la teneur est la suivante : « Aujourd’hui
je suis un guerrier. Je dois vous montrer mon ceoeur.

Je parcours la riviere de sang. » Worf a effectué

ce rite a I'age de 15 ans, en 2355. — Journal de bord :
« The Icarus Factor» (Icare) [ST: LNGI, « Sins of the
Father » (Les Fautes du pere) [ST: LNG]

VOIR DOSSIERS 11, 69

ﬁﬂe ﬂe némsmn C'est I'age auquel les Talariens

de sexe masculin deviennent adultes : a 14 ans.
— Journal de bord : « Suddenly Human »
(Soudainement Humain) [ST: LNG]

VOIR DOSSIERS 18, 69

L'aérotram est un mode de transport commode

et apprécié au xxine siecle. L'amiral Kirk

I'emprunte notamment pour se rendre au siége
de Starfleet afin de participer a une importante
réunion au sujet de la crise provoquée par la sonde
extraterrestre V'GER.

ROBNFS 201 BF 347 pewx eues rumains, soves

par une espéce extraterrestre inconnue et morts sur
la Terre avant d'avoir pu remplir leur mission, laquelle
consistait a sauver I'humanité de ses instincts
autodestructeurs. Gary Seven se verra confier
|'achevement de cette mission. — Journal de bord :
«Assignment . Earth » (Mission : Terre) [ST: LSC]
VOIR DOSSIER 68

H"'HEI Nom d'un humanoide miradorn. Apres la
mort de son jumeau Ro-Kel, tué par Croden au cours
d'un cambriolage, en 2369, le lien de synergie entre
Ah-Kel et son frére se trouve rompu, ce qui incite le
survivant a jurer vengeance. — Journal de bord :

« Vortex » [ST: DS9] VOIR DOSSIER 70

ﬂnﬂ'mﬂﬂﬂ Arme de combat rapproché utilisée par
les Vulcains. Elle se compose d'une sangle de cuir qui
peut se muer rapidement en une sorte de fouet ou

de lasso. — Journal de bord : « Amok Time » (Le Mal
du pays) [ST: LSC] VOIR DOSSIERS 8, 68

H|ﬂx, ”55 Comme les autres astronefs de classe
Apollo, ce vaisseau stellaire de la Fédération, portant
I'immatriculation NCC-11574, tire son nom d'un héros
de la mythologie antique, qui s'illustra lors de la guerre
de Troie. L“Ajax participe a maintes missions menées
par Starfleet au xxive siécle, et notamment au blocus
opéré par Picard au moyen de la grille de détection
par tachyons au cours de la guerre civile klingonne.
— Journal de bord : « Tapestry » (Tapisserie)

[ST: LNG], « Where No One Has Gone Before »

(Ou I'Homme surpasse I'homme) [ST: LNG],

« Redemption, Part Il » (Rédemption, 2¢ partie)

[ST: LNG] VOIR DOSSIERS 31, 69

H"." L'un des deux criminels vorgons qui tentent de
trouver Picard et le Tox Uthat en remontant le temps.
— Journal de bord : « Captain’s Holiday » (Les Vacances
du capitaine) [ST: LNG]

VOIR DOSSIERS 18, 69

DOSSIER 81 || FICHE 2 |

Alameda (Camorme)
Alan-a-Dale

Alans ‘

Alawanir, nébuleuse d'

Alba Ra

Albeni, cristal de méditation
Albert, Joshua

Le lien qui I'unissait a son

fréere jumeau Ro-Kel ayant
été brisé par I'assassinat de
ce dernier, le Miradorn Ah-Kel
est déterminé a se venger.
Le meurtrier est un fugitif
venu de la planéte Rakhar, du
nom de Croden.

Quartier Général

de Starfleet a San
Francisco : un aérotram
a quai, au terminus.
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Akaar, Leonard James

[l est devenu le chef ancestral —
Teer — des Dix tribus de la planete
Capella IV, dés sa naissance

en 2267, peu aprés la mort de son
pére Teer Akaar. Sa mere, Eleen,
I'a ainsi nommé en 'honneur

de James Kirk et de Leonard
McCoy. — Journal de bord :

« Friday’s Child» (Un Enfant

doit mourir) [ST: LSC]

VOIR DOSSIER 68

Leonard James Akaar, ainsi

prénommé - a la grande
surprise de Spock - en
hommage a Kirk et a McCoy.

Hkﬂﬂf, TEE[ Pé}é de Leonard

James Akaar, tué dans un combat
pour la souveraineté sur Capella IV.
Sa veuve, Eleen, est alors
enceinte : leur fils deviendra

chef dés sa naissance. — Journal
de bord : « Friday’s Child»

(Un Enfant doit mourir) [ST: LSC]
VOIR DOSSIERS 18, 68

Akaar, le Haut Teer, est tué
en 2267 par le guerrier
Maab, sur Capella IV.

HHanﬂf temﬂle ﬂ Sanctuaire, site cérémoniel d'ou les freres

Kron et Valt controlent leur empire galactique. Ce temple est utilisé
dans le cadre d'une simulation dans le holodeck pour recréer une
Cérémonie de Réconciliation entre deux systémes stellaires rivaux.
— Journal de bord : « The Perfect Mate » (Parfaite compagne)

" [ST: LNG] VOIR DOSSIER 69

Hhﬂ[ﬂ u 5 5 Ce vaisseau de classe Rigel, immatriculé NCC-62158,
porte le nom d'un navire de guerre nippon qui opéra sur les oceans

de la Terre au cours de la Deuxiéme Guerre mondiale. L' Akagi de

la Fédération participe au blocus imposé entre les forces de Duras

et les vaisseaux de ravitaillement romuliens lors de la guerre civile
klingonne de 2368. — Journal de bord : « Redemption, Part Il »
(Rédemption, 2¢ partie) [ST: LNG] VOIR DOSSIERS 31, 69

HH“."] Et Memm Titre d'un opéra klingon que le lieutenant Worf

apprécie tout particuliérement. — Journal de bord : « Unification, Part Il »
[ST: LNG] VOIR DOSSIERS 31, 69

HHmla Dirigeant du peuple indigene de
Gamma Trianguli V1. Par le truchement de
ses antennes, il recoit les directives de Vaal,
I'étre supréme de ce peuple — c'est pourquoi
on l'appelle «les Yeux de Vaal ». Akuta recoit
I'ordre de tuer les membres d'un détachement
de I'U.S.S. Enterprise. — Journal de bord :

« The Apple » (La Pomme) [ST: LSC]

VOIR DOSSIERS 18, 68

Akuta est en phase avec le «dieu»

de sa planéte, ce qui lui vaut d’étre +
considéré comme «les Yeux de Vaal »
sur Gamma Trianguli VI.

Hl LEUﬂn "ﬂﬂﬁﬂﬂ” Le transport entre Deep Space Four

et Caere, & bord duguel Richard Galen voulut voyager durant sa quéte
des origines des anthropoides de la Galaxie. — Journal de bord :

« The Chase » (Chasse a I'homme) [ST: LNG]

VOIR DOSSIERS 44, 69

s

FICHE 2

HIﬂmEﬂﬁ [Eﬂ" ﬂmm] Ville voisine de San Francisco, sur la Terre,

abritant & la fin du xxe siécle une vaste base navale des Etats-Unis.
Chekov y est capturé aprés qu'Uhura et lui ont pénétré sur la base
pour tenter de dérober des photons & haute énergie a bord du navire
américain Enterprise. — Journal de bord : Star Trek IV:The Voyage
Home (Star Trek IV: Retour sur Terre) VOIR DOSSIER 75

Hlﬂn'ﬂ'nﬂle Si I'on en croit une légende apparue sur la Terre,
dans I'’Angleterre du xixe siécle, ce troubadour et hors-la-loi fut un
compagnon de Robin des Bois. Geordi La Forge endosse son réle,
avec plus ou moins de réussite, dans une fantaisie née de I'imagination
de Q. — Journal de bord : « QPid» [ST: LNG]

VOIR DOSSIER 69

H'ﬂ“ﬁ Expert en minéralogie et vulcanologie de I'U.S.S. Enterprise
qui, en 2365, dirige une étude géologique sur les planetes de Selcundi
Drema. — Journal de bord : « Pen Pals » (Correspondance) [ST: LNG]
VOIR DOSSIER 69

Reconstitution dans le holodeck de I'antique temple d’Akadar,
site de la Cérémonie de Réconciliation entre Alrik et
I'ambassadeur kriosien Biam.

Hlﬂmﬂ"", HEDUIEUSE ']‘ Nuage de gaz et de poussiéres

interstellaires exploré par |'U.S.S. Enterprise en 2369. — Journal
de bord: «Rightful Heir» (L'Héritier légitime) [ST: LNG]
VOIR DOSSIER 69

H"]ﬂ Hﬂ Genre musical talarien, faisant appel a des sons
électroniques aussi puissants que discordants. — Journal de bord:
« Suddenly Human » (Soudainement Humain) [ST: LNG]

VOIR DOSSIERS 18, 69

H"]E"I, E“Slﬂl [IE mémrﬂ“ﬂ" Ce globe pé\e et vibrant

contribue & provoquer un état méditatif, par I'émission d'un doux
rayonnement. — Journal de bord : « Angel One » [ST: LNG]
VOIR DOSSIER 69

H"]E”, JﬂﬁhUﬂ Membre de I'escadrille Nova de I'Académie

de Starfleet, mort dans le crash de son vaisseau en 2368.

Wesley Crusher, lui-méme éleve officier & cette époque,

devait révéler lors de I'enquéte qui s'ensuivit que I'escadrille
d'Albert avait tenté une manceuvre illégale, qui fut considérée
comme la cause de I'accident. — Journal de bord : « The First Duty »
(Prise de commandement) [ST: LNG]

VOIR DOSSIERS 19,69
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Albert,
lieutenant |
CﬂmmﬂﬂdEf Officier :

de Starfleet, pere de
I'éleve officier Joshua
Albert. — Journal de
bord : « The First Duty »
(Prise de commande-
ment) [ST: LNG]
VOIR DOSSIER 69
Le lieutenant
commander Albert
ne parvient pas a

accepter la mort
tragique de son fils.

H'EUU"ES Le peuple des Alcyones parvient &

¢liminer le dernier vaisseau talérien vecteur de la
peste, en 2358. — Journal de bord: « Haven » (Haven)
[ST: LNG] VOIR DOSSIER 69

Aldabren, achange 0 racioue de

d'échecs tridimensionnel utilisée par Riker pour
vaincre le Ferengi Nibor lors d'une partie disputée

4 la conférence sur les accords commerciaux de 2366.

— Journal de bord: « Ménage a Troi» [ST : LNG]
VOIR DOSSIER 69

Hlﬂﬂfﬂ Le cuirassé cardassien de classe Galor
qui poursuit le militant bajoran Tahna Los jusqu’a
la station Deep Space Nine, ou celui-ci a cherche
refuge avec un convertisseur d'antimatiere dérobé.
— Journal de bord : « Past Prologue » [ST: DS9]
VOIR DOSSIERS 36, 47, 70

HmEﬂ Corps céleste jadis considéré comme
légendaire, ol les avancées technologiques ont
permis |'épanouissement d'un monde pacifique. Ses
citoyens s'adonnaient exclusivement a des pratiques
artistiques et intellectuelles. On découvrira qu'Aldea
est en fait une véritable planete occultée par ses
habitants afin d'empécher toute intrusion, ce qui a
pour résultat d'endommager sa couche d'ozone.

— Journal de bord: « When the Bough Breaks »
(Quand la branche casse) [ST: LNG.]

VOIR DOSSIERS 3, 69

-
HmEﬂns Habitants anthropoides d'Aldea. Les
radiations émanant de leur systéme d'occultation
planétaire ayant mis a mal la couche d'ozone
protectrice, les Aldéans souffrent de stérilité
chronique. lls enlévent des enfants de I'U.S.S.
Enterprise NCC-1701-D, dans le but de perpétuer
leur espéce. L'équipage intervient alors pour les aider
a démanteler le dispositif d'occultation. — Journal de
bord : « When the Bough Breaks » (Quand la branche
casse) [ST: LNG] VOIR DOSSIERS 18, 69

Hmenﬂ[ﬂ" ”I Planéte ou le Dr Janet Wallace

réalise des expériences avec des composés d'hydrate
de carbone dans le but de retarder la décomposition

de la vie végétale. Ces expériences seront utilisées
dans une tentative pour traiter la maladie dégénérative
causée par un virus accélérateur de vieillissement

qui sévit a bord de I'U.S.S. Enterprise en 2267.

— Journal de bord: « The Deadly Years » (Les Années
noires) [ST: LSC] VOIR DOSSIER 68

HlﬂEhﬂm", SE”]EM d‘ Reptile extraterrestre

dont la caractéristique la plus marquante est de
posséder trois tétes. Q prend’la forme d'un tel
serpent lors d'une visite qu'il rend a I'U.S.S.
Enterprise NCC-1701-D. — Journal de bord:

« Hide and Q » (Dans la peaude Q) [ST: LNG]
VOIR DOSSIER 69

Doté de la faculté de prendre toute forme a sa
fantaisie, Q se mue en serpent d’Aldebaran.

Aldebaran, Wwhiskey d' ceve soissor

extrémement forte, de couleur verdatre, est I'un

des rares spiritueux servis a bord de I'U.S.S.
Enterprise NCC-1701-D a n'étre pas a base de
synthéhol mais bien d’authentique alcool. Guinan en
conserve une bouteille derriere le bar Avant-Toute,
laquelle lui a été remise par le capitaine Picard.

— Journal de bord : « Relics » (Reliques) [ST: LNG]
VOIR DOSSIERS 7, 69

HmEha”]" Colonie stellaire a laquelle I'U.S.S.

Enterprise rend visite en 2265, lors d'une de ses
premiéres missions. Le Dr Elizabeth Dehner,
psychologue, embarque pour étudier les réactions
de I'équipage en situation de crise, avant une
rencontre tragigue avec un champ énergétique.

— Journal de bord: « Where No Man Has Gone
Before » (OU I'nomme dépasse I'homme) [ST: LSC]
VOIR DOSSIER 68

HlEXﬂ"nE[ Habitant de Platonius affecté d'une

déficience hormonale I'empéchant d'acquérir les
pouvoirs télékinétiques caractéristiques de son
peuple, ce qui est la cause de son nanisme.
Meécontent de son réle de bouffon du palais
platonien, il quitte sa planete avec un détachement
de I'U.S.S. Enterprise, en 2268. — Journal de bord :
« Plato’s Stepchildren » (La Descendance) [ST: LSC]
VOIR DOSSIERS 18, 68

mfﬁ ”7 Planéte de classe M ou une panne de
téléporteur §_cinde la personnalité du capitaine Kirk

bossien 51 | A 3 I

| Alliance, I

| Alpha Carinae Ii
Alpha Carinae V

] Alpha Centauri

7 Alpha Cygnus IX
Alpha lil

Sur la planéte Platonius

(que dirige Parmen, grand
amateur de Platon et doté de
pouvoirs télékinétiques), le
statut social d’Alexander est
aussi peu élevé que sa taille.

Le climat glacial d’Alfa

117 en fait un piéege
redoutable pour les membres
d’équipage de I'ENTERPRISE,
bloqués la a cause d'une
panne de téléporteur.
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en deux : une «bonne » et une « mauvaise ». Sur cette planéte,
les températures nocturnes descendent jusqu'a —85°C. — Journal
de bord : « The Ennemy Within » (L'lmposteur) [ST: LSC]

VOIR DOSSIER 68

algolians, rythmes CRramonielSenases musiares

que Riker reproduit sur les moteurs a distorsion du vaisseau ferengi
Krayton, en manipulant la phase du champ de distorsion. Ce son,
capté par I'U.S.S. Enterprise NCC-1701-D, révele que Riker,
Lwaxana et Deanna Troi sont détenus a bord. — Journal de bord :
«Ménage a Troi » [ST: LNG] VOIR DOSSIER 69

Alice au pays des Merveilles

Conte fantasmagorique de Lewis
Carroll (pseudonyme de I'Anglais
Charles Dodgson). Ce grand classique
de la litterature enfantine, publié au
XIx¢ siecle, est toujours apprécié sur
la Terre, par les adultes aussi bien
que par les enfants. Une équipe de
I'Enterprise en déplacement sur une
planete-parc d'attractions y rencontre
| des personnages du livre, en 2267.
— Journal de bord : « Shore Leave »
(Une Partie de campagne) [ST: LSC]
VOIR DOSSIER 68
Les mots deviennent réalité sur

| la planéte-parc d’attractions :

lorsque son nom est mentionné,

Alice apparait aux membres
d’équipage de I'"ENTERPRISE.

HIICE, ﬂ"["mde Modele d'androide féminin a la chevelure brune

preféeré de Harry Mudd lorsque celui-ci vit sur une planéte sans nom,
peuplée d'androides, dans la galaxie d'’Andromede. — Journal de
bord : «/, Mudd» (Mudd) [ST: LSC] VOIR DOSSIERS 55, 68

H"‘Iﬂf, VES La puissance de ce

Lumeérien lui vient de ce qu'il utilise
ses facultés d'empathie pour transférer
ses propres émotions négatives

vers autrui : 'individu qui recoit

ces sentiments préjudiciables,

le «réceptacle », se trouve affligé

de troubles de la personnalité et

de tensions physigues extrémes.

e Dr Beverly Crusher découvre le
comportement d'Alkar en enquétant
sur la mort de sa compagne Sev
Maylor. Alkar lu-méme meurt alors
qu'il tente d'utiliser Deanna Troi
comme réceptacle. —Journal de

bord : « Man of the People » (Le Tribun)
[ST: LNG] VOIR DOSSIERS 58, 69

Ves Alkar, un
ambassadeur qui
détient un secret mortel.

ﬁ“ﬂmﬂ[ﬂme Ce mot, crié lors d'une partie de Chula, indique
gu'un joueur vient de changer de niveau. — Journal de bord : « Move
Along Home » [ST : DS9] VOIR DOSSIER 70

anasamﬂmhe Métamorphe intelligent, capable de modifier

sa structure moléculaire pour reproduire celle d'autres formes de vie.
Anya et Salia, de Daled IV, sont des allasomorphes typiques.

— Journal de bord : « The Dauphin » (La Dauphine) [ST: LNG]

VOIR DOSSIERS 18, 69

Les membres d’équipage de la station DEEP SPACE NINE

se trouvent engagés dans un étrange jeu de réalité virtuelle.
Falow, qui dirige ce jeu de Chula, crie « allamaraine » pour
annoncer le passage au niveau suivant.

Allenbuy, enseigne Tess orcer e vor ce ru.s.s.

Enterprise NCC-1701-D, elle pilote le vaisseau lors de la mission
a Gamelan V, en 2367. Elle est aussi aux commandes quand le
vaisseau, en route pour T’lli Béta, rencontre un banc d'organismes
en deux dimensions. — Journal de bord : « Final Mission » [ST: LNG]I,
« The Loss » (La Perte) [ST: LNG] VOIR DOSSIERS 43, 69

- 4
H"m"ce, ' Apres I'effondrement du gouvernement colonial
au xxive siecle, ce bloc se heurte a son ennemi, la Coalition, pour
le contréle de la colonie planétaire de Turkana IV. L'Alliance tente
d'échanger I'équipage retenu prisonnier d'un vaisseau cargo de la
Fédération, |'Arcos, contre des armes provenant de I'U.S.S.
Enterprise NCC-1701-D. — Journal de bord : « Legacy » (Héritage)
[ST: LNG] VOIR DOSSIERS 18, 69

H'[]nﬂ Eﬁ“ﬂﬂe ” Cette planéte de classe M est employée pour

analyser les capacités de |'ordinateur M-5 dans le domaine des
opérations d'études et d'exploration planétaires. — Journal de bord:
« The Ultimate Computer » (Unité multitronique) [ST: LSC]

VOIR DOSSIER 68

H"]nﬁ Eﬂ“"ﬂe V Planete d'origine de Drella, créature qui se

nourrit d'émotion amoureuse. — Journal de bord : « Wolf in the
Fold» (Un Loup dans la bergerie) [ST: LSC] VOIR DOSSIER 68

Hlphﬂ m.l EenrﬂU[E Une des étoiles les plus proches du

systeme solaire, a quelque 4,3 années-lumiére du Soleil. En
détention sur une base de I'U.S. Air Force a la fin des années 1960,
le capitaine Kirk déclare au colonel Fellini qu'il est «un petit homme
vert» venu d'Alpha du Centaure. — Journal de bord : « Tomorrow
is Yesterday » (Demain sera hier) [ST: LSC], « Metamorphosis »
(Guerre, amour et compagnon) [ST: LSC] VOIR DOSSIERS 44, 68

Hmhﬂ Eugnus IX C'est a Sarek, le célebre ambassadeur

vulcain, que revient le mérite d'avoir négocié un traité entre cette
planete et la Fédération. — Journal de bord : « Sarek » [ST: LNG]
VOIR DOSSIER 69

Hlﬂhﬂ I" Ces statuts figurent dans I'un des grands documents
historiques étendant les libertés civiques a I'ensemble de la
Fédération. — Journal de bord : « Court martial » (Cour martiale)
[ST: LSC] VOIR DOSSIER 68
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H"]ha, IU"E 'un des deux satellites habités

de la planéte Peliar Zel, dont les occupants produisent
de I'énergie en exploitant le champ magnétique de
cette planéte, ce qui a des conséquences néfastes

sur I'environnement de la lune Béta. — Journal de bord :
« The Host» (L'Hote) [ST : LNG] VOIR DOSSIERS 3, 69

Hlpnﬂ Mﬂlﬂ”ﬁ | Planéte d'origine de |'organisme

mellitus, qui se déplace a |'état de vapeur et ne se
solidifie que lorsqu'il est immobile. — Journal de bord :
« Wolf in the Fold » (Un loup dans la bergerie)

[ST : LSC] VOIR DOSSIERS 3, 68

Hlﬂhﬂ ﬂmlcmﬂ, Susréme De passage en 2367

dans ce systéme stellaire non encore exploré I'U.S.S.
Enterprise NCC-1701-D rencontre une forme de vie
capable de survivre dans le vide intersidéral.

— Journal de bord : « Galaxy’s Child » (L'Enfant stellaire)

[ST : LNG] VOIR DOSSIERS 3, 4, 69

H'Dnﬂ l]mas "I Bien que les études de la

Fédération aient conclu a l'absence de vie sur

cette planéte, I'U.S.S. Enterprise NCC-1701-D détecte
dans ce secteur des oscillations qui tendent a indiquer
la présence d'une base romulienne. Explorant la
planéte, le commander Riker y découvre un enfant
extraterrestre du nom de Barash ; celui-ci, qui vit

dans une caverne, est capable de créer des mondes
fantastiques aussi élaborés gue convaincants.

— Journal de bord: « Future Imperfect » (Futur
imparfait) [ST : LNG] VOIR DOSSIERS 3, 69

Hll]nﬂ P”]leﬂ " Sur cette planete, plusieurs

femmes sont poignardées avec une sauvagerie

qui rappelle les actes barbares commis au xixe siécle
sur la Terre par Jack I'Eventreur. — Journal de bord :
« Wolf in the Fold » (Un Loup dans la bergerie)

[ST : LSC] VOIR DOSSIERS 3, 68

Hlﬂhﬂ. ﬂ”ﬂd[ﬂm Cette région de la Voie lactée,

dont les dimensions atteignent quelque 50000 années-
lumiére, comprend le gros des territoires administrés par

la Fédération. C'est la que se déroulent la majeure partie

des missions des U.S.S. Enterprise NCC-1701 et NCC-

1701-D. La station Deep Space Nine ainsi que les vortex

bajoran et barzan sont également situés dans ce
quadrant de la Galaxie. — Journal de bord : « Captive
Pursuit» [ST : DS9] VOIR DOSSIERS 3, 70

H'ﬂhﬂ V, El]mme C'est sur cette planéete

que résident les parents les plus proches du jeune
Charles Evans, unique rescapé d'un naufrage sur
Thasus. — Journal de bord : « Charlie X» [ST : LSC]
VOIR DOSSIERS 3, 68

ﬂlnhﬂ'gmseme, nEErﬂf Boisson wadie,

aussi rare que précieuse. Falow tente de s’en servir
comme d’une mise lors d'une partie de dabo, mais
Quark refuse, car il n'en aime pas la saveur.

— Journal de bord : « Move Along Home » [ST : DS9]
VOIR DOSSIERS 7, 70

O En raison de sa saveur jugée déplaisante, le
nectar alpha-groseille ne recoit pas I’agrément de
Quark pour servir de mise lors d’une partie de dabo.
Falow, lui, tient cette boisson en meilleure estime.

alpha, induckeur d'ondes apeere:

médical qui apporte le sommeil aux étres humains.
Cet inducteur, qui remplace les pilules et autres
substances somniféres, n’est cependant destiné
gu’a un usage occasionnel.

— Journal de bord : « The Passenger » [ST : DS9]
VOIR DOSSIERS 65, 70

HI“H, Chﬂ"EE"E[ Chef du gouvernement

de Valt Minor, ce personnage sérieux et rigoureux
dirige la cérémonie de Réconciliation qui met un
terme a de longues décennies de guerre entre son
peuple et le systeme de Krios. — Journal de bord :
« The Perfect Mate » (Parfaite Compagne)

[ST : LNG] VOIR DOSSIERS 18, 69

H"ﬂ” "I Commandant en second & bord de
|'U.S.S. Hood NCC-42296, Riker refuse de laisser
son supérieur, le capitaine DeSoto, se téléporter sur
la planéte Altair Ill, car selon luj cette mission
présente un caractére beaucoup trop dangereux.

— Journal de bord : « Encounter at Farpoint, Part | »
(Rendez-vous a Farpoint, 1re partie) [ST : LNG]

VOIR DOSSIERS 3, 69

H"ﬂ" W Planéte du quadrant Alpha, destination
initiale de I'U.S.S. Enterprise en 2267, pour une
cérémonie d'inauguration faisant suite a une tréve
interplanétaire..., mais Spock détourne le vaisseau
vers Vuleain pour y accomplir sa propre cérémonie
d‘accouplement. Altair IV figure aussi dans le test
d'aptitude de I'Académie, dit du Kobayashi Maru.
— Journal de bord : « Amok Time » (Le Mal du pays)
[ST : LSC], Star Trek Il : The Wrath of Khan

(La Colere de Khan) VOIR DOSSIERS 3, 73

H"ﬂ", Cﬂ"féfenﬁe d‘ Le capitaine Picard

rencontre le capitaine Rixx a cette réunion
interplanétaire, au milieu du xxive siecle. — Journal
de bord : « Conspiracy » (Conspiration) [ST : LNG]
VOIR DOSSIERS 19, 69

altonian, ¢
Altovar
Alture VIl p
de relaxation
Amanda
Amar, IK.C.
Amargosa
Amargosa, daspora
Amargosa, observatoire solaire
Amarie
Amazing Detective Stories
ambassadeur klingon |
Ambassador, classe de vaisseaux |

L’inducteur d’ondes alpha

est un appareil que I'on
emploie d’ordinaire pour
provoquer le sommeil sans
avoir recours a des substances
médicamenteuses. Il stimule
chez I’'humanoide la
production d’ondes alpha
par le cerveau, ce qui induit
un état de relaxation.

Le pragmatique chancelier

Alrik n’est pas ému outre
mesure par le don qui lui est
fait de la belle métamorphe
empathique Kamala.
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H"EC Cette planéte de classe M, située dans le systeme d'Omega
Sagitta, constitue une moitié de la coalition de Madena. Un fragile
armistice est observé avec les habitants de Straleb. — Journal de
bord : « The Outrageous Okona » (Okona le Magnifique) [ST : LNG]
VOIR DOSSIERS 3, 69

H"mE, Eﬂ"fém"fe I]‘ C'est a cette réunion de scientifiques

gu’en 2369 le Dr Beverly Crusher rencontre le Dr Reyga, un
Ferengi, avant de I'inviter a bord de I'U.S.S. Enterprise NCC-1701-D
pour y tester son invention, un bouclier métaphasique permettant
de pénétrer dans une couronne solaire. — Journal de bord :

« Suspicions » [ST : LNG] VOIR DOSSIERS 19, 69

En 2371, I'observatoire solaire d’Amargosa est anéanti par
une onde de choc provenant d’une étoile voisine, elle-méme
détruite par I’arme au trilithium qu’a concue le Dr Tolian Soran.

ﬂ"ﬂmﬂﬂ, EﬂSSE'rmE Aprés plus de quatre cents ans de

pratique, la symbiote Dax ne parvient toujours pas a maftriser ce
casse-téte holographigue. L'objectif est de transformer une sphere
multicolore en globe unicolore, au moyen de vibrations neurales
concentrées. — Journal de bord : « A Man Alone » [ST : DS9]
VOIR DOSSIER 70

H"UVM Ce criminel léthéen tente de dérober le gel
bioméimétique du Dr Bashir. Interrompu dans son forfait par
I'officier médical, Altovar |'attaque par des moyens télépathiques.
Bashir est plongé dans le coma. — Journal de bord : « Distant
Voices » [ST : DS9] VOIR DOSSIER 70

Alfure VI, programme de relaxafion ce prograrmme

du holodeck plonge I'utilisateur dans un bain de protéines, puis se
sert d'un nuage de vapeur pour le transporter dans une chambre de
méditation. — Journal de bord : « Birthright, Part [ » (Droit ancestral)
[ST : LNG] VOIR DOSSIER 69

Hmﬂ"ﬂﬂ D'abord institutrice sur la Terre, elle épouse ensuite

le diplomate vulcain Sarek, a qui elle donne un fils : Spock. Bien
qu'elle ait élevé son.fils dans la société vulcaine, elle s’est toujours
efforcée de le rendre conscient de ses caractéristiques humaines,
en particulier & la suite de la cérémonie du fal-tor-pan, en 2285. —
Journal de bord : «Journey to Babel » (Un Tour a Babel) [ST : LSC],
Star Trek V : The Final Frontier (L'Ultime Frontiere), Star Trek IV :
The Voyage Home (Retour sur Terre) VOIR DOSSIERS 44, 68, 75, 76

Hmﬂ[, |HE Croiseur cuirassé de la flotte spatiale klingonne,
de classe K’T’inga, détruit par V'Ger lors de sa rencontre avec
cette forme de vie mécanisée. — Journal de bord : Star Trek : The
Motion Picture (Le film) VOIR DOSSIERS 34, 72

DOSSIER 81 § FICHE 4 ]

Spock est a demi humain :

sa mére Amanda, une
Terrienne, va superviser sa
rééducation apreés la cérémonie
du fal-tor-pan qui s’est déroulée
sur Vulcain.

HmﬂmUSﬂ Etoile détruite

en 2371 par le Dr Tolian Soran,
agissant dans le but de réorienter
le Nexus pour lui faire suivre

le cours qui a sa préférence.

— Journal de bord : Star Trek J
Generations VOIR DOSSIERS 4, 78 §

Hmﬂ[ﬂ%ﬂ, ["ﬂSﬂ[lfﬂ Amas d'étoiles sphérique tres dense

étudié en 2369 par I'U.S.S. Enterprise NCC-1701-D. — Journal de
bord : «Schisms » (Schismes) [ST : LNG] VOIR DOSSIERS 3, 69

HmﬂfQUSﬂ, Uhsewﬂmue Sﬂlmfe Avant-poste scientifique

d'ou le Dr Soran observe I'étoile Amargosa ; mis a sac par les
Romuliens en 2371 et détruit peu aprés par une onde de choc. —
Journal de bord: Star Trek Generations VOIR DOSSIERS 42, 78

Rmﬂ“e Ex-femme d'un trafiquant d'armes, cette musicienne tire
de la possession de guatre bras un grand avantage au clavier : elle
en fait la démonstration dans un salon sur Qualor ll. — Journal de
bord: « Unification, Part Il» [ST : LNG] VOIR DOSSIERS 58, 69

Hmﬂzmg nerEEnVE Sm“es Titre d’une revue a sensation

dédiée au genre paralittéraire du « polar », tel gu'on le concevait
avant le milieu du xxe siécle aux Etats-Unis, sur Terre. C'est dans
Amazing Detective Stories qu'a été publiée en 1934 la premiere
nouvelle, The Big Goodbye, ayant pour héros le détective prive
Dixon Hill, dont Picard aura |'occasion d'endosser le réle dans
plusieurs simulations du holodeck. — Journal de bord : « The Big
Goodbye » (Le Long Adieu) [ST : LNG] VOIR DOSSIER 69

ambassadeur Klingon en 22e6

un diplomate klingon tente de faire
extrader et juger James Kirk,
prétendant qu'il a concu le projet
Genesis comme une arme de
destruction de masse dirigée contre
son peuple. En 2291, il s'oppose a la
libération de Kirk et de McCoy, arrétés
pour le meurtre du chancelier Gorkon.
— Journal de bord : Star Trek IV : The
Voyage Home (Retour sur Terre), Star
Trek VI : The Undiscovered Country
(Terre inconnue) VOIR DOSSIERS 11,
48, 75, 77

L’ambassadeur klingon n’a guére

d’estime pour James Kirlk, qu’il
considére comme un «renégat» et un
« terroriste ».

Ambassador, classe de VAISSRAUX +pe e vaisseau spaia

assez courant au sein de la Fédération, mis au point entre les
classes Constitution et Galaxy. L' U.S.S. Enterprise NCC-1701-C
est un vaisseau de classe Ambassador tout comme |'Adelphi
(immatriculé NCC-26849), le Zhukov (immatriculé NCC-26136)

et le second Excalibur (immatriculé NCC-26517). — Journal

de bord: « Yesterday's Enterprise » (L'Enterprise viendra d'hier)

[ST : LNG] VOIR DOSSIERS 24, 31, 69
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ﬂmme Ce gigantesque organisme unicellulaire, dont
les dimensions sont d'environ 18000 km de long sur
3000 km de large, posséde une membrane absorbant
I'énergie, capable de paralyser les vaisseaux ou autres
corps avoisinants, que |'amibe absorbe ensuite. Spock
parvient a détruire cet organisme et, partant, a sauver
I'U.S.S. Enterprise NCC-1701, en se servant d'une
navette pour implanter une bombe «antimatiére » dans
le noyau cellulaire de la colossale créature cosmique,
cette bombe jouant ainsi un role d'anticorps. — Journal
de bord : « The Immunity Syndrome » (Amibe) [ST : LSC]
VOIR DOSSIERS 58, 68

Hnﬂ“ 7 Dirigeant de la planéte Eminiar VII, il tente
d'empécher Kirk et quelques-uns de ses membres
d'équipage de venir sur sa planéete. En tant que chef
militaire, Anan 7 est responsable de la mort de milliers
de ses concitoyens, ce aux termes d'un étrange accord
avec la planéte ennemie Vendikar : pour éviter la
destruction des planétes, les frappes sont simulées

par ordinateur, mais les morts comptabilisés doivent
ensuite se faire désintégrer par des machines. Kirk ne
tient pas compte de l'avertissement d’Anan 7, et il finit
par le convaincre d'ouvrir des négociations de paix avec
le gouvernement de Vendikar. — Journal de bord :

« Taste of Armageddon » (Echec et diplomatie) [ST : LSC)
VOIR DOSSIERS 18, 68

anapestigue, [RIAMEITE cove metnoce

de construction poétique est employée par Data dans
son « Ode a Spot», composition versifiée qui rend
hommage au chat Spot, son animal de compagnie.

— Journal de bord : « Schisms » (Schismes) [ST : LNG]
VOIR DOSSIER 69

H"ﬂ[a Citoyenne bajorane qui effectue son stage
d'apprentissage d'ingénieur a bord de la station
Deep Space Nine, au cours de |'année 2369.

— Journal de bord : « The Forsaken » [ST : DS9]
VOIR DOSSIER 70

H"ﬂ“ﬂ, E"SElU"E HI]”I Membre de Starfleet,

elle sert a bord de I'U.S.S. Enterprise NCC-1701-D
lorsque celui-ci rencontre une sonde cythérienne
a la date stellaire 44704.2. — Journal de bord :

« Nth.Degree » (Le Nieme Degré) [ST : LNG]

VOIR DOSSIERS 19, 69

ﬂ"bﬂ‘lursu Cet art martial hybride, adapté de

diverses disciplines asiatiques fort anciennes, met

aux prises deux adversaires aux yeux bandés, qui
s'affrontent a coups de batons contenant des systemes
de guidage et d'évaluation des distances. Pour éviter
les blessures, les combattants portent une armure.

Le décompte des points s'effectue en fonction du
nombre de coups portés; on cherche aussi a expulser
I'adversaire du ring. A la date stellaire 42686.4,

le commander Riker apprend que son péere, Kyle Riker,
avec lequel il n'entretient plus de relations depuis des
années, avait triché lors de combats contre lui, son
propre fils. — Journal de bord : « The lcarus Factor »
(Icare) [ST : LNG] VOIR DOSSIERS 43, 69

DOSSIER 81| FICHE5S

Avant méme que I’'U.S.S. ENTERPRISE n’observe

la gigantesque amibe, Spock «ressent» la des-
truction de I'U.S.S. INTREPID, dont I'équipage est
vulcain. Cette amibe détruit également une grande
partie du systeme de Gamma 7A.

H"[:m”e, ﬂéVfB ﬂ‘ Cette virulente maladie

affecte tragiquement Styris IV, en 2364. Sé
répandant rapidement, elle peut devenir une épidémie
gravissime et causer la mort, dans d'abominables
souffrances, de millions d'individus. — Journal de
bord : « Code of Honor » (Le Code de I'honneur)

[ST : LNG] VOIR DOSSIER 69

ﬂ"flen Fﬂf wesr Cette simulation du holodeck,

située sur la Terre au xixe siécle, a pour cadre la ville
de Deadwood, dans I'Etat américain du Dakota du
Sud. Elle permet aux joueurs d'interpréter les roles
du shérif et d'un mystérieux étranger, entre autres.
Ce programme, congu par Reginald Barclay

a I'intention toute particuliere du jeune Alexander
Rozhenko, connait a la date stellaire 46271.5 un
dysfonctionnement qui expose Alexander et Worf
a un combat contre des bandits armés en nombre
croissant, compilés par le réseau neural de Data,
dont ils ont tous le visage. — Journal de bord :

« A Fistful of Datas » [ST : LNG] VOIR DOSSIER 69

Hnuevmn " Le quatrieme satellite de cette planete

est le lieu préféré de Lwaxana Troi pour ses interludes
romantiques. Quand elle souhaite aller y pique-niquer
avec Odo, elle réserve une holosuite au bar de Quark,
afin d'y concevoir I'environnement approprié.

— Journal de bord : « The Forsaken » [ST : DS9]

VOIR DOSSIERS 3, 70

ﬂﬂ[ll]"ﬂ", hfﬂnﬂu Une liqueur d'exception.

Quark tente d'amadouer les autorités wadies qui

I'ont surpris & tricher au dabo au moyen d'une bouteille
entiére de ce breuvage. — Journal de bord : « Move
Along Home » [ST : DS9] VOIR DOSSIERS 7, 70

ﬂﬂﬂﬂﬂlﬂﬂ, “]E Jean-Luc Picard, grand amateur

de thé Earl Grey, se voit offrir cette boisson par |'amiral
Aaron lors de sa visite au Quartier Général de
Starfleet, en 2364. — Journal de bord : « Conspiracy »
(Conspiration) [ST : LNG] VOIR DOSSIERS 7, 69

ﬂ"ﬂﬂ”ﬂﬂ, DIUES Style de musique dans lequel

s'exprime fréquemment la musicienne a quatre bras
Amarie. — Journal de bord : « Unification, Part I/ »
(Unification, 2e partie) [ST : LNG] VOIR DOSSIER 69

Andorie

anesthézine
Angel One
Angosia ili
angosian, vaisseau
de transport
Angosians
. anionique, énergie

Anan 7 ne parvient pas

a dissuader Kirk et son
équipage de se rendre sur
sa planéte, Eminiar VII.

Le programme holodeck

de I'ancien Far West,
congu pour le jeune Alexander,
ne se déroule pas tout a fait
comme prévu : des bandits
armés s’y multiplient.
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H"ﬂﬂﬂens Le membres

de cette espéce anthropoide

se distinguent par les antennes
gu'ils portent sur la téte. Bien
gu'’ils soient considérés comme
violents, ils appartiennent bel

et bien a la Fédération : une
délégation d’Andoriens s'est
rendue a la conférence de
Babel & bord de I'U.S.S.
Enterprise, en 2267. — Journal
de bord : « Journey to Babel »
(Un Tour a Babel) [ST : LSCI,

i «Whom Gods Destroy »

d (La Colére des dieux) [ST : LSC],
Star Trek IV : The Voyage
Home (Retour sur Terre),

« Captain’s Holiday »

(Les Vacances du capitaine)

[ST : LNG], «Data’s Day »

(Une Journée de Data) [ST : LNGI,
« The Offspring » (L'Enfant)

[ST : LNGI, « The Survivors »
(Les Survivants) [ST : LNG]
VOIR DOSSIERS 18, 68, 69, 75

Les Andoriens, caractérisés

par leur teint bleuté et leurs
antennes, sont parfois jugés
violents, ce qui ne les empéche
pas d’étre membres a part entiére
de la Fédération.

Hn["Eﬂ Ravissante androide

fabriguée par Roger Korby, qui a pour
cela utilisé des techniques mises au
point par un peuple depuis longtemps
disparu, les Anciens. L'archéologue
découvre que ceux-ci vivaient sous la
surface de la planete Exo Il avant
d'étre anéantis par les androides de
leur création. — Journal de bord :
«What Are Little Girls Made Of? »
(Planete des illusions) [ST : LSC]
VOIR DOSSIERS 55, 68

La belle androide du Dr Korby,

Andrea, est détruite par un tir de
fuseur de I'androide Korby, devenu
suicidaire aprés s’étre rendu compte
de la futilité de son existence.

ﬂﬂdmme Ce terme générique désigne les membres d’une classe
d'automates, généralement constitués a I'image d'homo sapiens, au
moyen d'un assemblage de matériaux mécaniques et biologiques.
Parmi les androides les plus notables, mentionnons Andrea, Norman
et Rayna Kapec. Data reste cependant le plus célébre des androides
dans les annales de la Fédération; il se distingue par la détermination
avec laquelle il s'efforce de devenir aussi humain que possible, ce qui
lui vaudra d'étre le premier androide a se voir attribuer officiellement
le statut de citoyen de la Fédération, en tant qu'étre sensible et
conscient. — Journal de bord : «/, Mudd» (Mudd) [ST : LSCI], « Return
to Tomorrow » (Tu n'es que poussiere) [ST : LSCI, « Requiem for
Methuselah » (Requiem pour Mathusalem) [ST : LSC], « What Are Little
Girls Made Of ?» (Planete des illusions) [ST : LSC], « Encounter at
Farpoint » (Rendez-vous a Farpoint) [ST : LNG], « The Measure of a
Man » (Etre ou ne pas étre) [ST : LNG], « The Offspring » (L'Enfant)
[ST : LNG], Star Trek Generations, Star Trek : First Contact.
(Premier Contact) VOIR DOSSIERS 55, 68, 69

H"dmméd& Uﬂlﬂxm ﬂ‘ C'est la plus proche voisine de la

Voie lactée, notre galaxie; on pense que dans les 10000 ans & venir
les niveaux de radiations croissants dont elle est le siege la rendront
inhospitaliere pour les multiples formes de vie planétaire qu'elle abrite.
— Journal de bord : « By Any Other Name » (Retour sur soi-méme)
[ST : LSC] VOIR DOSSIERS 3, 68
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Le docteur Katherine Pulaski

est médecin-chef a bord de
I'U.S.S. ENTERPRISE NCC-1701-D
quand celui-ci est frappé par une
vague d’encéphalite andronésiane.

andronasiane, encaphalite

Maladie infectieuse qui se caractérise °
par une inflammation du cerveau.

Le Dr Katherine Pulaski traite les
membres d'équipage de I'Enterprise
atteints de cette affection vers la

date stellaire 42568. — Journal de
bord : « The Dauphin » (La Dauphine)
[ST : LNG] VOIR DOSSIER 69

: .
ﬂnESrhezme Tranquillisant sous forme gazeuse, employé par

le personnel de I'Enterprise afin de contenir les foules tumultueuses
et maitriser les individus non coopératifs, tels que Roga Danar.

Son emploi sera limité en raison de l'inefficacité de son application
aux androides et autres étres non biologiques. — Journal de bord :

« The Hunted » (Le Fugitif) [ST : LNG], « Power Play » (Rapports de
force) [ST : LNG] VOIR DOSSIER 69

H"ﬂ&l I]HE Cette planete de classe M, située prés de la Zone
neutre romulienne, est occupée par une société de type matriarcal,
ou le pouvoir s'exerce par le biais d'une démocratie représentative,
les méles étant traités en inférieurs. En 2357, I'Odin, un vaisseau de
la Fédération, est désemparé prés d'Angel One, ou quatre membres
d'équipage sont contraints de jouer les fugitifs. — Journal de bord :
«Angel One » [ST : LNG] VOIR DOSSIERS 3, 18, 69

H"gﬂﬁlﬂ ”I Cette planéte de classe M demande a entrer dans

la Fedération en 2366, au cours d'une période de querelles intestines.
Le gouvernement angosian, qui se livre sur ses citoyens a des
manipulations mentales et a des altérations biochimiques, cherchera
par ailleurs a obtenir I'aide de Starfleet pour capturer un prisonnier
évadé, Roga Danar, a la réputation d’extréme violence.

— Journal de bord : « The Hunted » (Le Fugitif) [ST : LNG]

VOIR DOSSIERS 3, 18, 69

ﬂ"ﬂﬂﬁlﬂ", VﬂlSSEﬂU de ”ﬂ"ﬁﬂﬂ” Petit astronef dépourvu

de facultés d'occultation ou de propulsion a vitesse de distorsion,

employé au sein du systeme angosian. Roga Danar s'empare de

I'un d'eux lors de son évasion. — Journal de bord : « The Hunted »
(Le Fugitif) [ST : LNG] VOIR DOSSIERS 40, 69

Hnﬂﬂsmns Les habitants d'Angosia lll sont les héritiers d'une
longue histoire marquée par la non-violence et le désir de se cultiver.
Au cours de la guerre tarsiane des années 2300, le gouvernement
emploie des techniques de génie biochimique pour créer une force
militaire d’'une efficacité supérieure. Les anciens combattants,
incapables de se réinsérer dans la société angosiane, seront incarcérés
dans une colonie pénitentiaire, sur un satellite de la planéte. La
demande d'adhésion d’Angosia Il & la Fédération est alors reportée
jusqu’au reglement des troubles opposant le gouvernement aux
ex-soldats. — Journal de bord : « The Hunted » (Le Fugitif) [ST : LNG]
VOIR DOSSIERS 18, 69

ﬁﬂmmﬂUE, EHE“]IE Type d'énergie formée de particules

de niveau quantique, découverte dans les synapses cérébrales des
membres d'équipage de |I'Enterprise en butte aux facultés de controle
mental des hors-la-loi Ux-Mal. — Journal de bord : « Power Play »
(Rapports de force) [ST : LNG] VOIR DOSSIER 69
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Hn"ﬂnE"E. Sé”e Androide femelle créé en 2267

par I'escroc Harcourt Fenton Mudd, plus connu sous
le nom de « Harry » Mudd, voire Mudd [er]

— Journal de bord : «/, Mudd» (Mudd) [ST : LSC]
VOIR DOSSIERS 55, 68

H"Sﬂtﬂ Groupe séparatiste radical opérant sur le
continent occidental de Rutia IV, ou il cherche & obtenir
I'indépendance & partir de 2296. Le gouvernement
rutien refuse obstinément de reconnaitre ce
mouvement, aussi certains membres se lancent-ils
dans I'action terroriste : ils enlévent notamment

le capitaine Picard et le Dr Crusher, en 2366, dans
le cadre d'une tentative effectuée pour arracher
I'engagement de la Fédération dans leur lutte.

— Journal de bord : « The High Ground » (Les Hautes
Terres) [ST : LNG] VOIR DOSSIERS 18, 69

Ankares [classe), vaisseau cargo

Type de vaisseau fort courant dans maintes flottes de

la Fédération au xxive siécle. Le cargo Corvallen qui
ameéne M'ret & la Fédération en 2369 est un vaisseau
de classe Antares, tout comme |'astronef que Starfleet
utilise pour leurrer les Cardassiens et les amener a
révéler que |'amiral Kennelly agit de connivence avec
eux en 2368. — Journal de bord : « Ensign Ro »
(Enseigne Ro) [ST : LNG], «Face of the Enemy » (Le
Visage de I'ennemi) [ST : LNG] VOIR DOSSIERS 31, 69

H"rﬂms, USS Vaisseau scientifique de la

Fédération, que Charles Evans, doté de pouvoirs
psychokinétiques terrifiants, a détruit peu apres que
|'Antares |'a secouru en 2266. Ce vaisseau porte le
nom d'une étoile qui, observée de la Terre, est la plus
brillante dans la constellation du Scorpion. — Jourhal de
bord : « Charlie X» [ST : LSC] VOIR DOSSIERS 31, 68

H"“Cﬂ Planéte mére des Anticans, Antica est
I'une des deux seules planétes habitables du systéme
stellaire de Béta Renna. — Journal de bord : « Lonely
Among Us » (Le Solitaire) [ST : LNG]

VOIR DOSSIERS 3, 18, 69

H"“Eﬂns Les habitants d'Antica, instruits et
carnivores, caractérisés par leur corps imposant et

hirsute ainsi que par leur goGt pour la chair vivante.
Avec |'aide de I'U.S.S. Enterprise-D, ils cherchent

& mettre un terme a leur conflit prolongé avec la race
selay, afin de pouvoir se joindre a la Fédération

en 2364. — Journal de bord : « Lonely Among Us »
(Le Solitaire) [ST : LNG] VOIR DOSSIERS 18, 69

Hﬂ“ﬂe "l Planéte mére des Antidéens, située a
environ trois jours de trajet (& vitesse de distorsion)
de la planéte océanique Pacifica. — Journal de bord :
«Manhunt » (Chasse a I'homme) [ST : LNG]

VOIR DOSSIERS 3, 69

anfideen. ambassadelr crer oe i mission

antidéenne a la conférence interstellaire de Pacifica

'DOSSIER 81

antipm‘tﬁt‘t‘

Antos IV

Anya

anyons, émetteur d
Aclien, amas
Apella

Apgar, Dr Nel

Le capitaine Kirk et I'enseigne Garrovick se

servent d’un dispositif antigrav pour transporter
une bombe d’antimatiére sur la planéte Tycho IV, dans
une tentative de destruction d’une entité nébuleuse.

en 2365, il exploite son statut et son rang diplomatiques
pour dissimuler un complot visant a faire exploser une
bombe & ultritum en pleine conférence. — Journal de
bord : « Manhunt » (Chasse a I'homme) [ST : LNG]
VOIR DOSSIERS 18, 69

= -
H"“ﬂeens Race hominoide mais présentant divers

traits d'ordinaire propres aux poissons. Les Antidéens
ont besoin d'importantes quantités de nourriture, en
particulier au sortir de I'état de catatonie auquel ils ont
recours lors de leurs déplacements interplanétaires.
Leur aliment préféré a pour nom vermicula. — Journal
de bord : « Manhunt » (Chasse a I'homme) [ST : LNG]
VOIR DOSSIERS 18, 69

ﬂ"“ﬂ[ﬂv Dispositif portatif équipant les vaisseaux de
la Fédération, employé pour manipuler et transporter
les objets trop lourds pour étre portés par un seul
membre d'équipage. Parmi les usages variés de
I'antigrav mentionnés dans divers journaux de bord,
signalons le transport d'une bombe d'antimatiere sur

la planéte Tycho IV, le déplacement du robot Nomad
vers une salle de téléportation et I'aide a la manutention
de palettes de marchandises. — Journal de bord :

« Obsession » [ST : LSCI, « The Changeling »

(Le Korrigan) [ST : LSCI, « /s there In Truth No Beauty 7 »
(Veritas) [ST : LSC], « Hollow Pursuits » (Fantasmes
holographiques) [ST : LNG], «Disaster » (Désastre)

[ST : LNG], « The Passenger » (Le Passager) [ST : DS9]
VOIR DOSSIERS 59, 68, 69, 70

antileptonique, inferference

Les antileptons constituent un champ de particules
actives qui créent des interférences avec les systemes
de communications des vaisseaux. En 2369, les
Cardassiens libérent des antileptons pour empécher

la station Deep Space Nine d'entrer en contact avec
Starfleet. — Journal de bord : « Emissary » (L'Emissaire)
[ST : DS9] VOIR DOSSIERS 13, 60, 70

ﬁn“mﬂ“ém Forme de la matiere constituée

d'antiparticules (positons, antiprotons, antineutrons),
de méme masse que les particules de matiere

Les Anticans, étres

hirsutes et carnivores,
cherchent a intégrer la
Fédération en 2364 ; ils
doivent auparavant mettre
un terme a leurs querelles
antérieures.

Les Antidéens, a

I'apparence d’étres
aquatiques, ont besoin
d’énormes apports nutritifs
quand ils quittent I'état de
catatonie dans lequel ils
effectuent leurs déplacements.
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correspondantes (électrons,
protons, neutrons), mais dont

les autres caractéristiques

—dont la charge électrique —

sont contraires. Tout contact entre
particules et antiparticules a pour
conséquence leur annihilation,

ce qui degage de |'énergie.

Cette réaction est exploitée dans
les propulseurs a distorsion des
vaisseaux de Starfleet. — Journal
de bord : « The Naked Time »
(L'Equipage en folie) [ST : LSC],

« The Apple » (La Pomme)

[ST : LSC] VOIR DOSSIERS 64, 68

Sous ces traits

agréablement humains
se dissimule I'allasomorphe
Anya, protectrice de la
princesse Salia.

anfimatiere, confinement 08 I cu: erue necossaie

au fonctionnement s(r et efficace de la propulsion & distorsion; il est
atteint par I'emploi de champs magnétiques destinés a empécher
I'antimatiere d’entrer en contact avec toute surface appartenant au
vaisseau. Une panne du systéme de confinement, ou une rupture du
cceur de distorsion, a généralement pour conséquence la destruction
du vaisseau, comme |'a montré la catastrophe du Yamato en 2365.
A plusieurs reprises, |'Enterprise-D se trouve tout prés de subir

une telle avarie. — Journal de bord : « Where Silence Has Lease »
(L'Empriee du silence) [ST : LNGI, « Cause and Effect» (Causes et
effets) [ST : LNGI], « 77007007 » [ST : LNG], « Violations » [ST : LNG],
« Cost of Living » (Le Prix d'une vie) [ST : LNG] VOIR DOSSIERS 64, 69

ﬂmlmﬂ“ﬁ[e, mmE ﬂ‘ Charge explosive transportée par les

vaisseaux de Starfleet. Une navette de |'Enterprise-D emploie

une batterie de mines d'antimatiére dotée d'une capacité de visée
magnétique afin d'intimider I'armada cardassienne dans la nébuleuse
McAllister C-5. — Journal de bord : « Chain of Command, Part Il »
(Hiérarchie, 2 partie) [ST : LNG] VOIR DOSSIERS 60, 69

anfimaliere, propagafion 0 oieposs mofrensit, consttus

de petites charges comparables a des feux d'artifice, mis en ceuvre
par les vaisseaux de la Fédération afin de créer une diversion propre &
plonger un adversaire dans la confusion. L' Enterprise-D |'utilise contre
les Borgs lors de la bataille de Wolf 359, en 2367, pour masquer le
départ d'une navette. — Journal de bord : « The Best of Both Worlds,
Part I'» (Le Meilleur des deux mondes, 2¢ partie) [ST : LNG]

VOIR DOSSIERS 60, 69

ﬂmmmmﬂ Particule élémentaire, de charge négative, entrant dans
la composition des noyaux atomiques d'antimatiére. La dégradation des
antiprotons dégage des rayons gamma. Les traces de telles radiations
permettent a I'Enterprise-D de traquer la meurtriére Entité cristalline
(date stellaire 45122). — Journal de bord : « Silicon Avatar » (L' Avatar

de cristal) [ST : LNG] VOIR DOSSIERS 5, 69

Hﬂms W Planéte membre de la Fédération habitée par un peuple
non violent et altruiste doué de facultés métamorphiques. Le capitaine
Garth, de Starfleet, y est soigné avant de perdre la raison (date
stellaire 5718). De gros invertébrés rampants vivent également sur
Antos IV. — Journal de bord : « Whom Gods Destroy » (La Colére

des dieux) [ST : LSCI, « Who Mourns for Adonis » (Pauvre Apollon)

[ST : LSC] VOIR DOSSIERS 3, 18, 68
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I
H"Lﬂ Allasomorphe originaire d'un satellite de Daled IV, protectrice
de la princesse de cette planéte, Salia, lors de son séjour & bord de
I'Enterprise-D. Pour 'équipage, Anya prend I'aspect d'une femme,
mais on ignore sa forme intrinséque. — Journal de bord : « The
Dauphin » (La Dauphine) [ST : LNG] VOIR DOSSIERS 54, 69

ﬂm.IU"S, émen‘em- [j‘ Dispositif dont se sert Data pour éviter

une prolifération des particules chronitons & bord de |I'Enterprise-D,
celle-ci étant provoquée par un générateur d’interphase romulien.
Il va aussi servir & «déphaser » Geordi La Forge et I'enseigne Ro
— Journal de bord : « The Next Phase » (Déphasage) [ST : LNG]
VOIR DOSSIERS 60, 69

HU"E", ﬂmﬁg Le professeur Richard Galen méne une enquéte
archéologique au sein de ce secteur, pour retrouver des indices au
sujet des premiers occupants humanoidss de notre galaxie.

— Journal de bord : « The Chase » (Le Secret) [ST : LNG]

VOIR DOSSIERS 3, 6, 69

Les Klingons

compromettent
I'équilibre des forces
sur la planéte de
Tyree, en livrant des
armes aux villageois
en situation
d’infériorité
technologique.
Dans le but de
redresser la situation,
le capitaine James
Kirk se sent dans
I'obligation de doter
Tyree et son peuple
des collines d’armes
équivalentes.

HﬂE"ﬂ Apella dirige les villageois opposés au peuple des collines

de Tyree, sur une planéte ou I'Enterprise arrive en 2267. Les Klingons
fournissent des armes primitives (fusils a pierre) aux partisans d’Apella,
dans le but de rompre le délicat statu quo qui régne sur cette planéte.
— Journal de bord : «A Private Little War» (Guerre et magie) [ST : LSC]

VOIR DOSSIER 68
Hﬂﬂﬂ[, ﬂ[ NEI Ce savant

tanugan est tué en 2366
dans I'explosion de sa base
de recherches. Sa veuve,
Mauna Apgar, accuse

le commander Riker de
complicité dans sa disparition,
mais celui-ci sera innocenté

a la suite d'une reconstitution
menée dans le holodeck,
laissant clairement supputer

| que le Dr Apgar a lurméme
tenté de tuer Riker. — Journal
| de bord : « A Matter of
Perspective » (Une Question
de perspective) [ST : LNG]
VOIR DOSSIERS 58, 69

En 2366, le commander
Riker est inquiété a la suite
de la mort - accidentelle ? -
du Dr Nel Apgar. Il faudra
une reconstitution dans le
holodeck pour établir que
la responsabilité du drame
incombe a Apgar lui-méme.
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ﬂl]nﬂﬁm Perte de la parole ou de la compréhension
du langage due & une lésion corticale. La population de
Deep Space Nine est victime en 2369 d'une aphasie
d'origine virale qui empéche ceux qui en sont atteints

de traiter mentalement ou de reconnaitre les impulsions

auditives et visuelles normales. — Journal de bord :
« Babel» [ST : DS9] VOIR DOSSIER 70

ﬂﬂhﬂsm, V"US Germe pathogéne mis au point par

le scientifique Dekon Elig, en vue d'un usage terroriste
par les Bajorans a |'encontre des Cardassiens.
Transmis par voie aérienne ou par les aliments, il infecte
initialement les Jobes temporaux de I'héte, dont il
perturbe les capacités de communication. Faute de
traitement, il finit par atteindre le systeme nerveux,
provoguant le coma et la mort. — Journal de bord :
«Babel» [ST : DS9] VOIR DOSSIER 70

HD"EX, mE[ Océan de la planéte Romulus qui

s'étend tout prés du domicile de I'amiral romulien
dissident Alidar Jarok. — Journal de bord :

« The Defector» (Le Transfuge) [ST : LNG]

VOIR DOSSIERS 12, 49, 69

H[m"mﬂ”ﬂ, [” Ce médecin exergait a I'hopital des

Sceurs de |'Espérance, & San Francisco, au xixe siecle. Il
était réputé pour son manque de tact, notamment dans
ses rapports avec les infirmiéres. — Journal de bord :

« Time's Arrow, Part Il » (La Fléche du temps) [ST : LNG]
VOIR DOSSIER 69

Rpollo [classe], VaiSSeal caegore ce

spationefs de la Féderation. L' U.S.S. Ajax et I'U.S.S.
Agamemnon sont tous deux de classe Apollo. Ce nom
est également celui d'un programme spatial des Etats-
Unis d’Amérique a la fin du xxe siécle, qui visait la
conguéte de la Lune. — Journal de bord : « Tapestry »
(Tapisserie) [ST : LNGI, « Descent» (La Descendance)
[ST : LNG] VOIR DOSSIERS 31, 69

ﬂl]ﬂ"[m Etre adoré comme une divinité par les
humains de la Gréce antique; ceux-ci voyaient en lui

le dieu de la Lumiére, de la Beauté, des Arts et de

la Divination. Apollon a quitté la Terre pour s'établir sur
Pollux IV. En 2267, il retient I'équipage de |'Enterprise,
dont il exige — en vain — qu'il reste sur sa planete et

le vénére. — Journal de bord : « Who Mourns for
Adonais » (Pauvre Apollon) [ST : LSC]

VOIR DOSSIER 68

HI][]E'. Ed Ingénieur responsable de la
transformation des minerais sur la planete Janus VI,
il fait partie des défenseurs de la colonie contre

la Horta (entité vivante présentant I'aspect d'une
masse siliceuse rampante), avant que les humains

ne parviennent & établir un modus vivendi pacifique
avec cette créature intelligente. — Journal de bord :

« The Devil in the Dark » (Les Mines de Horta) [ST : LSC]
VOIR DOSSIERS 7, 68

April, capiraine RoBert T. premier capiaine

de I'U.S.S. Enterprise, commandant le vaisseau lors
de sa mission inaugurale de cing ans, a partir de 2245.
Lui succéderont les capitaines Christopher Pike puis
James T. Kirk. VOIR DOSSIER 20

ﬂﬂ”ﬂﬂ”t Canal d'adduction d'eau pour les lieux de

" DOSSIER81 | FICHE7 |

Peu avant de mourir, le chef du Haut Conseil

klingon, K'mpec, a désigné le capitaine Picard
Arbitre de la Succession. Dans ce réle, Picard
attribue la direction du Conseil a Gowron.

peuplement et les terres agricoles. Les Terriens utilisent
des aqueducs depuis plus de quatre mille ans, et la
planéte Bajor dispose encore de tels réseaux en 2369.
— Journal de bord : «Birthright, Part | » (Droit ancestral)
[ST : LNG] VOIR DOSSIERS 10, 69

ﬂm.”m]. EHSEMHE Membre d'équipage de Deep

Space Nine; il est tué alors qu'il s'oppose a la tentative
d'assassinat perpétrée par Neela a I'encontre de Vedek
Bareil, un chef spirituel bajoran, en 2369. — Journal de
bord : «In the Hands of the Prophets » (Entre les mains
des prophétes) [ST : DS9] VOIR DOSSIERS 47, 70

H”]aZﬂn Peuple membre de la Fédération. Leur
ambassadeur, Taxco, ressent comme une insulte
I'insinuation de I'ambassadeur Vadosia selon laquelle
les Arbazans refoulent leurs pulsions sexuelles, insulte
proférée lors d'une enquéte sur le vortex bajoran
conduite & Deep Space Nine. — Journal de bord :

« The Forsaken » (Abandon) [ST : DS9]

VOIR DOSSIER 70

Arbitre de |3 SUCCESSION te contere 2

I'individu chargé de superviser le rite de Succession
klingon, qui détermine celui qui dirigera le Haut
Conseil klingon. Cette fonction d'arbitrage ne revient
pas nécessairement a un Klingon, cela méme si I'Arbitre
est fréquemment amené a régler des différends

— comme le fait le capitaine Picard, choisi en tant
qu'intervenant neutre aprés la mort de K'mpec par
empoisonnement. — Journal de bord : « Reunion »
(Réunion) [ST : LNGI, « Redemption, Part [ »
(Rédemption) [ST : LNG]

VOIR DOSSIERS 11, 43, 69

Hﬂ:hﬁms L officier navigateur Sulu se sert de
cette étoile pour aider I'Enterprise a retrouver son cap
aprés que le vaisseau a été propulsé a travers la Galaxie
par les Metrons, en 2267. — Journal de bord :
«Arena» [ST : LSC] VOIR DOSSIERS 3, 68

Hfﬂhﬂnlﬁ W Avant-poste scientifique ou I'enseigne

Pavel Chekov prétend que son frere fictif, Piotr
Chekov, a été assassiné par les Klingons. — Journal
de bord : «Day of the Dove » (La Colombe) [ST : LSC]
VOIR DOSSIERS 3, 43, 68

Ardana
Ardra
Argéliens
Argelius Il
argine
Argolis, amas

L’arche du holodeck est

accessible par commande
vocale, pour mettre fin au
holoprogramme ou lui
apporter une modification,
mais aussi pour transmettre
des messages personnels.

La planéte Bajor posséde

un réseau d’aqueducs
assurant I'alimentation en
eau des villes et I'irrigation
des terres.
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Sous l'influence de

I'entité de Béta XII-A,
I'enseigne Pavel Chekov
affirme que les Klingons
ont tué son frére sur
Archanis IV.

ﬂf[: nE L'entrée du

holodeck de I'Enterprise-D,
par laquelle les membres
d'équipage vont et viennent
entre le monde d'illusion de
la simulation holographique
et la réalité du vaisseau
spatial. L'arche peut étre
dissimulée afin que le
holoprogramme emplisse

la totalité du champ visuel
du holodeck, mais elle
redevient visible sur simple
commande. — Journal de
bord : « Elementary, Dear
Data » (Elémentaire, mon
cher Data) [ST : LNG] VOIR
DOSSIERS 25, 59, 69

o .
ﬂrﬁnemﬂgle Etude des civilisations du passé, par la mise au jour
et 'analyse d"éléments matériels tels que sépultures, édifices, outils...
tous les vestiges des cultures disparues. Le capitaine Picard, qui a
&tudié les lconiens dans le cadre de son cursus a |'’Académie de
Starfleet, continue de s'intéresser a cette discipline. — Journal de
bord : « Contagion » (Contagion) [ST : LNG] VOIR DOSSIERS 6, 69

HfEth w C'est la destination de |'Enterprise-D avant sa rencontre
avec |'Enterprise-C dans un monde spatio-temporel parallele.

— Journal de bord : « Yesterday's Enterprise » (L'Enterprise viendra
d'hier) [ST : LNG] VOIR DOSSIERS 3, 69

H[EhE[ W F[mﬂmje Pﬁ[ﬂ“ﬁl&] Planéte ou les Klingons sont

défaits par la Fédération dans |'univers paralléle et ou I'Enterprise-C
se retrouve aprés que I'explosion d'une torpille & photons a provoque
une bréche temporelle dans |'espace, en 2344. — Journal de bord :
« Yesterday's Enterprise » (L'Enterprise viendra d'hier) [ST : LNG]

VOIR DOSSIERS 3, 69

H[Chﬂn, ”SS Astronef de Starfleet disparu aux abords de

Béta lll en 2167, aprés avoir été arraché & son orbite par |'ordinateur
Landru. L'équipage de I'’Archon est assimilé par la population de la
planéte gouvernée par Landru. Un siécle plus tard, |'Enterprise vient
enquéter. — Journal de bord : « Return of the Archons » (Le Retour
des Archons) [ST : LSC] VOIR DOSSIERS 18, 68

H[Enﬂns Aprés leur absorption par la société de Béta lll, les
membres d'équipage de I'U.S.S. Archon sont désignés sous le nom
d'«Archons ». Comme le reste des habitants de la planete, ils voient
leur personnalité soumise aux stimuli de I'ordinateur Landru, qui
impose une société placide et dépourvue de toute créativité.

— Journal de bord : « Return of the Archons » (Le Retour des
Archons) [ST : LSC] VOIR DOSSIERS 18, 68

H[Cﬂs. USS Ce vaisseau cargo de Starfleet explose en 2367
aprés une rupture du systéme de confinement d'antimatiére du
propulseur & distorsion. L'équipage parvient a gagner la planete
Turkana IV, ou il est fait prisonnier par la faction de I'Alliance.

— Journal de bord : «Legacy » (Héritage) [ST : LNG]

VOIR DOSSIERS 18, 31, 69

Hrtuhlre Planéte du systeme de Clarus sur laquelle le Ferengi
Nava prend le controle des raffineries, ce qui lui vaut les félicitations
du Grand Nagus Zek, en 2369. — Journal de bord : « The Nagus »
(Le Grand Nagus) [ST : DS9] VOIR DOSSIERS 3, 70

3

Hmﬂ"ﬂ Cette planéte de classe M, membre de la Fédération,
recoit en 2269 la visite de |'Enterprise, venu prendre livraison d'une
cargaison de zénite retenue a la suite d'un conflit entre les riches
résidents de Stratos et les mineurs d'Ardana. — Journal de bord :
« The Cloud Minders » (Nuages) [ST : LSC] VOIR DOSSIERS 3, 68

Conformément a la

prophétie, Ardra doit
revenir sur Ventax Il au
bout de mille ans pour
réclamer le paiement de
sa dette; une femme se fait
passer pour Ardra, mais
I'imposture sera révélée.

H“:"a Selon la théologie

de Ventax I, le démon Ardra
est un étre mythique issu
d'un lointain passé, qui a
promis a la population un
millénaire de prospérité;
d'aprés la prophétie,
toutefois, au retour d’Ardra
les habitants de Ventax Il
seront réduits en esclavage.
En 2367, une femme
débarque sur la planete et
en revendique la possession,
en vertu du contrat autrefois
passé. Au moyen de diverses supercheries fondées sur des
technologies avancées, elle reproduit plusieurs phénoménes censés
annoncer le retour d’Ardra, ce qui amene les Ventaxiens & croire

en son caractére divin. Elle sera démasquée par le personnel

de I'Enterprise-D. — Journal de bord : « Devil's Due » (Le Tribut

du démon) [ST : LNG] VOIR DOSSIER 69

P M
H[gE"E"S Hospitaliers et hédonistes, les habitants de la planete
Argelius I, qui ont abandonné les meeurs brutales du passe, retiennent
brievement Montgomery Scott prisonnier, car ils le soupgonnent
d'étre I'auteur d'une,série de meurtres commis en 2267. — Journal
de bord : « Wolf in the Fold» (Un Loup dans la bergerie) [ST : LSC]
VOIR DOSSIERS 18, 68

Hfﬂehus " Planéte occupée par une population humanoide, les
Argéliens, et site d'un spatioport d'importance stratégique. — Journal
de bord : « Wolf in the Fold» (Un Loup dans la bergerie) [ST : LSC]
VOIR DOSSIERS 18, 68

Montgomery Scott

est accusé a tort de
meurtre sur Argelius i,
planéte si hospitaliére
et épicurienne que ce
crime innommable
souléve une incrédulité
horrifiée. On découvrira
que la malfaisante entité
Redjac est responsable
de I'assassinat de
plusieurs femmes.

ﬂfﬂme Substance

hautement inflammable,

I'argine de sorium constitue la charge d'une bombe autodirectrice
destinée a tuer Quark alors que celui-ci exerce les fonctions de Grand
Nagus. — Journal de bord : « The Nagus » (Le Grand Nagus) [ST : DS9]
VOIR DOSSIERS 51, 70

Hfﬂmls, ﬂmﬂs ["amas Argolis est une région de I'espace instable

et mal connue contenant six systémes stellaires ainsi que la planéete
Tagra IV. Un vaisseau de reconnaissance borg désemparé y est
découvert en 2368. — Journal de bord : «/, Borg» (Hugh, le Borg)
[ST : LNG], « True-Q» (Q ou non?) [ST : LNG] VOIR DOSSIERS 3, 69
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suite
H[QUS, “Vléfg Le bassin de I'Argus, sur la planete

Rigel IV, est occupé par le peuple des collines. En
2267, on découvre qu’'une arme utilisée par le tueur

en série Redjac provient de cette région. — Journal

de bord : « Wolf in the Fold» (Un Loup dans la bergerie)
[ST : LSC] VOIR DOSSIER 68

fArgule, lieutenant commander en o

qu'ingénieur-chef de I'U.S.S. Enterprise NCC-1701-D,
Argyle supervise la reconstitution et I'initialisation de
I'androide Lore. Il est aussi de service lorsque Kosinsky
et le Voyageur expédient malencontreusement

' Enterprise dans une région de |'espace située

4 350 millions d'années-lumiére de la Fédération,

ouU les pensées deviennent réalité. — Journal de bord :
« Where No One Has Gone Before » (Ou I'Homme
surpasse I’homme) [ST : NGI, « Datalore » (Data et Lore)
[ST : LNG] VOIR DOSSIERS 43, 69

H"ﬁnﬂ Fille de Wrenn, un des dirigeants de

la planéte Tarella, elle est I'une des rares a ne pas
succomber au virus mortel libéré par une arme
biologique lors des guerres tarelliennes. Dans ses
efforts pour sauver les siens de I'extinction, Ariana
exploite les liens de nature prémonitoire qui I'unissent
au Dr Wyatt Miller. — Journal de bord : « Haven »
[ST : LNG] VOIR DOSSIERS 18, 69

Hﬂﬂnnus En 2268, cette planéte est ravagée par une
meurtriére prolifération bactérienne qui menace toutes
les formes de vie. L'U.S.S. Enterprise NCC-1701 est
amené & superviser une décontamination hyperbolique,
afin que soit préservé le role crucial que joue Ariannus
dans le domaine des échanges commerciaux
interstellaires. — Journal de bord : «Let That Be

Your Last Battlefield » (Le Dilemme) [ST : LSC]

VOIR DOSSIERS 3, 68

H”E' Alors qu'elle

appartient a |'organe
dirigeant de la societé
matriarcale qui regne
sur Angel One, Ariel
épouse secretement
Ramsey — un membre
d'équipage d’un
vaisseau de la
Fédération désemparé
a proximité de sa
planéte — au grand dam
de ses consceurs
opposées a toute
réforme susceptible de
tendre vers une égalité
de droits pour les
hommes. — Journal
de bord : «Angel One »
[ST: LNG] VOIR
DOSSIERS 18, 69

Ce sont les femmes qui régnent sur Angel One,

ot1 les hommes sont réduits a un statut de citoyens
de seconde classe. Ariel défie les conventions en
épousant Ramsey, un membre d’équipage de Starfleet.

H"ES, USS Vaisseau spatial de la Fédération, de
classe Renaissance, immatriculé NCC-45167. En 2365,
William Riker refuse une promotion qui lui octroierait
le commandement de ce batiment — il a choisi de rester

En 2268, I'entité de Béta XII-A transforme en

sabres et épées les armes de I’'armurerie de
I’'U.S.S. ENTERPRISE NCC-1701.

fidele a I'U.S.S. Enterprise NCC-1701-D. C'est a bord
de I'Aries qu'est assigné 'homme d'équipage Mendez,
avant sa disparition en 2367. — Journal de bord :

« The lcarus Factor » (Icare) [ST : LNGI, «Identity Crisis »
(Crise d'ldentité) [ST : LNG] VOIR DOSSIERS 31, 69

H”’m”ﬂ. DQSE Ce poste de la Fédération gere un

vaste complexe orbital, le Remmler Array. — Journal
de bord : «Starship Mine » (28 Minutes pour vivre)
[ST : LNG] VOIR DOSSIERS 32, 69

H”ﬂens, nﬂ”é ﬂ‘ Cet accord fort complexe,

conclu entre les dirigeants du peuple sheliak (constitué
d'extraterrestres non humanoides) et la Fédération,
est ratifié en 2255. Aux termes de cet accord, la
souveraineté des Sheliaks va s'exercer sur plusieurs
planétes de classe H. En 2366, c'est en application

de ce traité que les xénophobes sheliaks exigent
|"évacuation d'une colonie de.la Fédération implantée
sur Tau Cygna IV. — Journal de bord : « Ensigns

of Command » (Prise de commandement) [ST : LNG]
VOIR DOSSIERS 18, 19, 69

ﬂ”ﬂU[E“E A bord des vaisseaux de la Fédération,
c'est dans |'armurerie que sont entreposées

et entretenues les différentes armes individuelles.

— Journal de bord : « Day of the Dove » (La Colombe)
[ST : LSC] VOIR DOSSIERS 60, 68

H[mus Cet étre maléfique tue sans raison apparente
Tasha Yar lors d'une mission de sauvetage. Armus
est une création des anciens occupants de Vagra I,
qui ont congu cette représentation du Mal dans le but
de purger leur propre personnalité de ses aspects
malfaisants et d'autres causes de souffrance. lls ont
ensuite quitté la planéte en abandonnant la créature.
On pense qu'Armus — qui se présente sous un aspect
rappelant le pétrole brut, tout en possédant la faculte
de prendre une forme humanoide ~ serait toujours

sur la planéte. — Journal de bord : « Skin of Evil»
(L'Essence du Mal) [ST : LNG] VOIR DOSSIERS 58, 69

mmUS |X C'est sur cette planéte que, pour des
raisons diplomatiques, le commander Will Riker est
amené & se parer de plumes. — Journal de bord :
«Angel One » [ST : LNG] VOIR DOSSIERS 3, 69

HmEh Alors qu'il s'interroge sur son avenir,
Wesley Crusher voit cette étoile par les baies du bar
Avant-Toute. — Journal de bord : « The Child »
(L'Enfant) ¥8T : LNG] VOIR DOSSIERS 3, 69

artoniens, |
Arvadalif
Asimov, Isaac

Aster, Jeremy

Aster, lieutenant Marla
Astral V, annexe
Astral Queen

E TR

En tant qu’ingénieur

en chef a bord de
I'U.S.S. ENTERPRISE,
le Lt. commander Argyle est
I'officier a qui échoit la tache
de reconstituer le «frére »
de Data, Lore.

Le Dr Arridor, infortuné

délégué ferengi, disparait
avec son pilote dans le vortex
barzan. lls en ressortent au
sein du quadrant Delta.
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H”'m][, [" Ce membre de la délégation ferengie chargée de
négocier les droits de passage dans le vortex barzan disparait en 2366
lorsqu’une issue du vortex se déplace jusque dans le quadrant Delta.
Arridor a extrait les composants volatils de la pyrocyte utilisée par

le DaiMon Goss pour empoisonner le Dr Mendoza, représentant

de la Fédération a la table des négociations. — Journal de bord :

« The Price » (Le Prix) [ST : LNG], « False Prophets » [ST : VOY]

VOIR DOSSIERS 51, 69, 71

La planete Minos,
également connue sous
le nom d’Arsenal de la
Liberté. Les Minosiens ont été
tués par leurs propres armes.

fArsenal de la Liberfe

C'est la qualification donnée
par les habitants de Minos

— depuis longtemps disparus —
3 leur planéte dans le but de la
promouvoir en tant que source
d'approvisionnement en armes
diverses. Autre slogan
commercial a succes :

« La paix gréce a une puissance
de feu supérieure ». — Journal de bord : « The Arsenal of Freedom »
(L'Arsenal de la Liberté) [ST : LNG] VOIR DOSSIER 69

H”emls, 55 En 2274, ce vaisseau recoit pour mission

de transporter des colons vers Septimus Minor mais, par suite

d'un dysfonctionnement des systémes de navigation, il se pose

sur Tau Cygna V, en violation du traité d’Armens. — Journal de bord :
« Ensigns of Command» (Prise de commandement) [ST : LNG]

VOIR DOSSIER 69

H[mn, I]Ef Membre d'équipage de I'U.S.S. Enterprise
NCC-1701-D, ex-petit ami de Jenna D’Sora avant la liaison avortée
entre celle-ci et Data en 2367. — Journal de bord : «In Theory »
(En Théorie) [ST : LNG] VOIR DOSSIER 69

ﬂrmmﬂns, lﬂSEfS Des armes de ce type, dérobées par

les Détrousseurs acamariens, seront retrouvées dans leur camp
sur Gamma Hromi Il. — Journal de bord : « The Vengeance Factor »
(Vengeance) [ST : LNG] VOIR DOSSIER 69

L'extraterrestre Tosk,
conditionné pour étre le
gibier d’une traque, cherche
refuge a bord de la station
DEEP SPACE NINE, ou le
chef O’Brien prendra fait
et cause pour lui.

arva, nodules

Ces nodules convertissent la
matiére intersidérale en source
d'énergie. C'est ce carburant
gu’emploie le vaisseau
appartenant a |'extraterrestre
Tosk. Ces nodules ayant été
endommagés, Tosk cherche
refuge a bord de Deep Space
Nine. — Journal de bord :

« Captive Pursuit» (ST : DS9)
VOIR DOSSIER 70

H{Vﬁdﬂ ”l Site d'une mystérieuse et meurtriére tragédie, tournant

de I'existence de Beverly Crusher. Celle-ci acquiert sa connaissance

des thérapies paralléles et autres médecines douces en ceuvrant avec
sa grand-mére a la guérison des survivants, alors méme qu’elle ne

" DOSSIER 81 |

dispose pas de ressources médicales modernes. — Journal de bord :
« The Arsenal of Freedom » (L'Arsenal de la Liberté) [ST : LNG]
VOIR DOSSIERS 3, 69

HS""UV, |Saﬂc Biochimiste et écrivain américain du xxe siecle,

auteur d'une théorie selon laquelle il serait possible de produire
des robots dotés d'un cerveau positronique. Plus de 300 ans plus
tard, le Dr Noonien Soong s'inspire des idées d'Asimov pour
ses propres travaux dans le domaine cybernétique, travaux qui
aboutissent & la construction des androides Data et Lore.

— Journal de bord : « Datalore » (Data et Lore) [ST : LNG]

VOIR DOSSIER 55, 699

fster, Jeremuy

Ce jeune garcon est le fils
du lieutenant Marla Aster.
Aprés la mort de sa mere
dans une explosion
accidentelle survenue en
2366, Jeremy refuse |'offre
des Koinoniens qui se
proposent de lui fournir
une réplique de Marla et

un environnement évoguant
la Terre. Au lieu de cela,

il trouve le réconfort dans
les facultés d'empathie

de Wesley Crusher et

la chaleur de I'accueil que
lui ménage la famille de
Worf. Jeremy regagnera
ultérieurement la Terre pour
y étre élevé par sa famille.
— Journal de bord :

« The Bonding » (Filiation)
[ST : LNG]

VOIR DOSSIERS 43, 69

En tant que dirigeant de la mission au cours de laquelle a été
tuée Marla, la mére de Jeremy Aster, Worf recueille I'orphelin
dans sa propre famille, conformément a la tradition klingonne.

HSTE[, ||9|.||'Eﬂﬂm Mﬂ”ﬂ Meére de Jeremy Aster, archéologue

affectée & bord de I'U.S.S. Enterprise NCC-1701-D. Elle est tuée

en 2366 par une vieille bombe datant de la guerre koinonienne, qui
explose accidentellement alors qu'elle est en mission hors du vaisseau.
Les Koinoniens, au sens éthique fort élevé, proposent de créer une
réplique de Marla en mesure d'élever |'orphelin, mais cette offre est
rejetée. — Journal de bord : « The Bonding » (Filiation) [ST : LNG]

VOIR DOSSIERS 18, 69

HS“GI V, ﬂnnexe Musée des astronefs historiques de la

Fédération. Le capitaine Jean-Luc Picard pense qu'il pourrait étre
intéressé par |'acquisition des vestiges du croiseur promélien
Cleponiji. — Journal de bord : « Booby Trap » (Piégés!) [ST : LNG]
VOIR DOSSIERS 7, 69

Hsrfﬂl uUEEH Vaisseau de transport de passagers, placé sous

le commandement du capitaine de la Fédération Jon Daily.
Faute d’avoir pu emprunter |'Astral Queen, qui n'a pas fait escale
sur la planéte Q, la troupe théatrale de Karidian monte a bord
de I'U.S.S. Enterprise NCC-1701, ce qui aura des conséquences
fatidiques. — Journal de bord : « The Conscience of the King »

(La Conscience du roi) [ST : LSC] VOIR DOSSIER 68

Hm“ﬂ V" Lieu d'une conférence diplomatique ou le capitaine
Picard est empéché de jouer un réle de médiateur, & la suite de

la mort de Richard Galen, en 2369. — Journal de bord : « The Chase »
(Le Secret) [ST : LNG] VOIR DOSSIER 69
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Slife
ﬂrﬂVﬂEnm" Ce dispositif permet a la population

de Sarpéidon de voyager dans le temps, vers le passeé,
aprés |'explosion de |'étoile Béta Niobe survenue

en 2269. La technigue employée, qui consiste

a modifier la composition cellulaire de |'utilisateur,
présente pour grave inconvénient de rendre
pratiquement impossible tout voyage temporel

de retour. — Journal de bord : «All Our Yesterdays »
(Le Passé) [ST : LSC] VOIR DOSSIER 68

HmE"EE Service d'archivage officiel implanté sur
Ventax Il, ol sont consignés les Rouleaux d’Ardra.

— Journal de bord : «Devil’s Due» (Le Tribut du Démon)
[ST : LNG] VOIR DOSSIERS 18, 69

H“ﬂ"“ﬂe, ﬂmler Ce plan d'origine terrestre visait

a construire un huitiéme continent artificiel dans I'océan
Atlantique, a la fin du xxive siécle. Cette terre nouvelle
devait reprendre le nom d’un ancien royaume
légendaire. Malgré la participation a ce projet de I'un

de ses amis d’enfance, le capitaine Jean-Luc Picard
refusera d'étre nommé au poste de directeur du
programme, ce afin de conserver le commandement
de son vaisseau, I'U.S.S. Enterprise NCC-1701-D.

— Journal de bord : « Family » (En Famille) [ST : LNG]
VOIR DOSSIER 69

afmosphere, conditionnement d

Les équipements vitaux des vaisseaux spatiaux

de la Fédération Unie des Planetes ont pour
élément essentiel des pompes spéciales, dites

de conditionnement d'atmospheére, qui assurent

la respirabilité du mélange d’oxygene et d'autres
particules dans les spationefs. En 2367, Data, alors
sous le contréle du Dr Noonien Soong, parvient

a passer outre les interverrouillages de sécurité

et a inverser le fonctionnement de ces pompes.

— Journal de bord : « Brothers » (Les Fréres) [ST : LNG]
VOIR DOSSIERS 25, 6

M. Atoz, bibliothécaire responsable de
FV’atavachron, juge a tort que les membres
d’équipage de I'U.S.S. ENTERPRISE font partie
de sa propre société, et les expédie dans le passé!

H“." Agent klingon dépéché sur Deep Space Nine
pour observer une délégation romulienne. — Journal
de bord : « Visionary » [ST : DS9] VOIR DOSSIER 70

HmZ, M Conservateur de |'énorme bibliotheque

de Sarpéidon en 2269, M. Atoz est le dernier habitant
de cette planéte a la quitter lors de I'explosion de
I'étoile Béta Niobe, autour de laquelle s'organise

le systeme stellaire. Les habitants de Sarpéidon, qui
ont fait usage de I'atavachron pour échapper a la mort
en ayant recours au voyage temporel, se sont servis
de la bibliotheque pour choisir la période du passé
dans laguelle ils souhaitaient s'établir. — Journal de
bord : «All Our Yesterdays » (Le Passé) [ST : LSC]
VOIR DOSSIERS 18, 68

aubergines, ragod 0" ce mets » bass

d'aubergines, préparé selon une vieille recette de la
famille Sisko, est servi a bord de la station Deep Space
Nine. Jadzia Dax |'apprécie tout particulierement.

— Journal de bord : « The Nagus » (le Grand Nagus)

[ST : DS9] VOIR DOSSIERS 7, 70

’

ﬁUdEt IX Localisation d'une station de collecte
médicale de la Fédération. L'U.S.S. Enterprise
NCC-1701-D y préléve des échantillons de peste
plasmique et les convoie jusqu’au dépot Tango Sierra.
— Journal de bord : « The Child» (L'Enfant) [ST : LNG]
VOIR DOSSIER 69

HUfUm En 2269, le Dr Sevrin s'empare de

ce vaisseau de la Fédération pour conduire un groupe
de jeunes idéalistes vers une planéte utopique, Eden.
— Journal de bord : « The Way to Eden» (Le Chemin

d’Eden) [ST : LSC] VOIR DOSSIERS 44, 68

H”S“ﬂmmméque Humanoide primitif qui vécut

sur Terre il y a de 3 a 5 millions d'années. En 2370, le
commander William Riker, victime du syndrome de
protomorphose de Barclay, se mue en protohumain
présentant tous les caractéres d'un Australopitheque.
Atteints du méme mal, qui entraine une régression
vers un stade antérieur de |'évolution de leur espéce,
Deanna Troi redevient amphibienne, Worf sanglier et
Barclay araignée... — Journal de bord : « Genesis »
(La Genese) [ST : LNG] VOIR DOSSIER 69

HUW[IUE Dirigeant de la planéte meére des

Tzenkethis, en 2371. — Journal de bord : « The
Adversary » [ST : DS9] VOIR DOSSIER 70

ﬂumnesrmﬂem Cet appareil, porté par tous

les membres d'équipage de I'l.S.S. Enterprise

dans I'univers-miroir, sert a infliger des chatiments.

— Journal de bord : « Mirror, Mirror » (Miroir) [ST : LSC]
VOIR DOSSIERS 68, 41

ﬂUfUdES"UE“Uﬂ Séquence d'instructions

données au systeme informatique primaire de presque
tout vaisseau spatial de la Fédération qui, si elle n’est
pas annulée, aboutit a la destruction du spationef.

Le protocole d'activation exige I'intervention de deux
officiers supérieurs. Le capitaine Jean-Luc Picard

a lancé a trois reprises la séquence de commande

de sabordage a bord de I'U.S.S. Enterprise.

autophaseur, interverrouillage
autoséquenceul
autosuture

«Auxiliary Control Center»
Avery il

Avidynes, moteurs

Axanar

axionique, puce
Ayelborne

Azetbur

azna

En 2269, le Dr Sevrin et
ses disciples s‘emparent
du S.S. AURORA, pour tenter
de fuir le monde moderne
et trouver Eden, la planéte
parfaite.

En 2370, le commander

Riker, de I'U.S.S.
ENTERPRISE NCC-1701-D,
«régresse » au stade
d’Australopithéque.
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OLe capitaine Kirk parvient a faire fonctionner ce qui reste des
systemes de I'U.S.S. CONSTITUTION, en utilisant I'« Auxiliary
Control Center» (centre de contrdle auxiliaire).

— Journal de bord : « 11001001 » [ST : LNGI; « Where Silence Has
Lease » (L'Emprise du silence) [ST : LNGI; Star Trek : Premier Contact
VOIR DOSSIERS 25, 69, 79

autophaseur, inferverrouilage ceve procsaure

informatique permet une synchronisation trés précise des opérations
lors d'un tir de barrage déclenché par les phaseurs d'un astronef.

— Journal de bord : «A Matter of Time » (Question de temps)

[ST: LNG] VOIR DOSSIER 69

ﬁm%éﬂuencems Cet ensemble de composants en interaction

est vital pour le fonctionnement sar et efficace des appareils de
téléportation. Lorsqu'elle fait défection pour rejoindre les Romuliens,
en 2367, le sous-commander Selok a recours a une simulation

de panne d'autoséquenceur pour faire croire a sa propre mort et ainsi
dissimuler sa fuite. — Journal de bord : « Data’s Day » (Une Journée
de Data) [ST : LNG] VOIR DOSSIERS 59, 69

ﬂumsumm Dispositif médical employé pour refermer les plaies
d'origine traumatiques ou'les incisions effectuées a I'occasion d'une
intervention chirurgicale. — Journal de bord : « Suddenly Human »
(Soudainement humain) [ST : LNG] VOIR DOSSIERS 65, 69

ﬂUX"lﬁfu EU"“UI EEME[ Ce centre de contréle auxiliaire est en

fait une sorte de passerelle de commandement secondaire, présente
4 bord de I'U.S.S. Enterprise NCC-1701 et d'autres spationefs de
Starfleet. En cas de nécessité, cet organe de secours pourrait servir
3 assurer la continuité du commandement et le fonctionnement

des systémes majeurs du vaisseau. — Journal de bord : « The Way
to Eden » (Le Chemin d’'Eden) [ST : LSC] VOIR DOSSIERS 20, 68

ﬂVEfu m Planéte du quadrant Delta, ou les Vidiians possedent
un complexe souterrain. Le Dr Sulan s'y livre a des expériences
sur B’Elanna Torres. — Journal de bord : « Faces » [ST : VOY]
VOIR DOSSIER 71

ﬂvmunes, mﬂtems Ces moteurs a impulsion représentent le top

de la technologie au moment de leur implantation sur les spationefs
de classe Constitution. Devenus obsolétes en 2365, ils continueront
d'étre utilisés dans des simulations de combats et d'autres exercices
organisés par Starfleet. — Journal de bord : « Peak Performance »
(Jeux de guerre) [ST : LNG] VOIR DOSSIERS 30, 69

b

HXﬂﬂﬂ[ Théatre d'une bataille livrée au xxiie siecle, qui se solde
par un retentissant triomphe de la Fédération : le capitaine Garth,
de Starfleet, s'impose avec éclat. Le capitaine Kirk, amené a
séjourner sur cette planéte au cours de sa formation a I'Académie
de Starfleet, tient Garth en haute estime; il attribue a cette victoire
I'établissement de ses liens privilégiés avec Spock. — Journal

de bord: « Whom Gods Destroy » (La Colére des dieux) [ST : LSCI;
« Court martial » (Cour martiale) [ST : LSC] VOIR DOSSIERS 19, 68

ﬂXlUm[er, [NJEE Module intégré au calculateur sensoriel de tous

les exocomps. — Journal de bord : « The Quality of Life » (Vie et mort
d'un exocemp) [ST : LNG] VOIR DOSSIER 69

AIbOMe cret

I'énigmatique Conseil des
Anciens de la planéte Organia,
il prédit avec justesse, en 2267,
que I'Empire klingon et la
Fédération finiront par dépasser
leurs différends d'ordre politique.
Comme tous les Organiens,
Ayelborne est en fait un étre
non corporel hautement évolug,
possédant la faculté de prendre
une apparence physique
humanoide. — Journal de bord :
« Errand of Mercy » (Les Arbitres
du cosmos) [ST : LSC]

VOIR DOSSIERS 18, 68

Dans les années 2260,

Ayelborne et le C i
organien des Anciens
contribuent a éviter qu’une
guerre n’éclate entre la
Fédération et I'Empire klingon.

HZE”]”[ Cette

Klingonne pleine

de ressources accede
au poste de chancelier
du Haut Conseil aprés
I'assassinat de son pére,
Gorkon, survenu en
2293. Elle poursuit les
négociations entreprises
par Gorkon avec la
Fédération Unie des
Planetes, lesquelles
trouveront leur
aboutissement dans la
signature du traité de paix
de Khitomer. — Journal
de bord : Star Trek VI :
Terre inconnue

VOIR DOSSIERS 48, 77

Devenue chancelier

du Haut Conseil
klingon aprés
I'assassinat de son
pére, Gorkon, Azetbur
meéne a leur terme les
négociations de paix
entreprises avec
la Fédération.

ﬂznﬁ Festin dont Jadzia Dax, qui |'apprécie particuliérement, pense
qu'il pourra prolonger I'existence de Benjamin Sisko. — Journal de
bord : « A Man Alone » (Un homme seul) [ST : DS9] VOIR DOSSIER 70



